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The MPR-9400 is equipped with normally open PV array relays. The controller will sample the PV current input at five minute intervals by energizing these relays and will search for current flow. (Pre-set at the factory at 5 or 10 minutes - window 316). During this sample time, the MPR-9400 will monitor the PV current input. If there is any power input detected from the PV arrays, the normally open relays will remain energized and the controller will control the High Voltage Disconnects (HVDs) and reconnects to charge the batteries. If there is no power detected from the arrays after the reconnect of the PV arrays, the controller will de-energize the PV relays and will then begin the 5 or 10 minute sampling described above. This feature is implemented so that the arrays are not energized during the evening hours or periods of sunless hours.

As a control method, if the initial start up of the MPR9400 does not detect any PV current input, it will de-energize the normally open PV relays. The controller will begin its programmed 5 or 10 minute sampling until PV current is detected.

To ensure the PV relays remain energized on start up, connect the PV arrays by turning on the PV circuit breakers before connecting the main battery disconnect.
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CONTROL WIRING
I/O CARD’s INPUT and OUTPUT CONNECTIONS
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I/O DESCRITIONS AND FUNCTIONS

ANALOG INPUTS

1. Controller circuit’s power input – “POW IN”
2. Battery voltage sense input – “BATT SENSE”
3. Battery Temperature sensor input – “BATT TEMP”
4. Solar Insolation input – “AUX IN 1”
5. Wind shunt input – isolated – “AUX IN 2”

6. Rectifier shunt input – isolated – “AUX IN 3”

7. Load shunt input – not isolated – “LDS”

8. PV shunt input – not isolated – “PVS”

9. Optional 6 channel MUX Card (Not Shown) (if installed) (all 6 channels can be configured for either Analog OR Digital inputs – all isolated)

DIGITAL INPUTS

1. Generator Fault – voltage free contact closure input – “FAULT 1” (optional voltage input)

2. Fault #2 – voltage free contact closure input – “FAULT 2” (optional voltage input)

3. Optional 6 channel MUX Card (Not Shown) (all 6 channels can be configured for either Analog OR Digital inputs – all isolated)

DIGITAL OUTPUTS

1. Sub Array #1 relay driver – 8 amp FET driver – “HVD1” A- BATT POS., B- BATT NEG.

2. Load #1 relay driver – 8 amp FET driver – “LVD1” A- BATT POS., B- BATT NEG.

3. Sub Array #2 relay drivers – 8 amp FET driver – “AUX” A- BATT POS., B- BATT NEG.

4. Sub Array #3 relay drivers – 8 amp FET driver – “CHAN 7” A- BATT POS., B- BATT NEG.

5. Load #2 relay drivers – 8 amp FET driver – “CHAN 8” A- BATT POS., B- BATT NEG.

6. AC Delay relay driver – 8 amp FET driver (external relay driver) – “CHAN 9” A- BATT POS., B- BATT NEG.
7. HVA 1FormC voltage free contacts “CHAN 4”  NO-C-NC
8. LVA 1FormC voltage free contacts “CHAN 5”  NO-C-NC
9. GEN 1FormC voltage free contacts “CHAN 6”  NO-C-NC
NOTE: THE RS232 DB9 connector on the CPU card, P/N – MPR-9401-01, IS NOT ISOLATED, THE DB9’s PIN #5 is referenced to battery negative. 

DO NOT CONNECT A PC ETC. TO THE RS232 THAT IS POWERED BY A POSITIVE GROUNDED SOURCE! 

INTRODUCTION

The information contained in this manual will provide the knowledge necessary to properly install, operate and maintain the MPR-9400 controller.  DST STRONGLY RECOMMENDS THAT THE USER READS AND FULLY UNDERSTANDS ALL PORTIONS OF THIS MANUAL PRIOR TO INSTALLATION AND USE. 

TERMINOLOGY USED IN THIS MANUAL

AMP-HOURS
A measurement of amperage provided by a charging source or that is available from the battery’s over a time period in hours.
AUXIN#
An auxiliary analog input.

EBBM
Energy Based Battery Management - This is DST’s name for the Amp Hour counting Deficit Recovery Charge Algorithm to enhance battery life.

FAULTIN#
A digital fault input.  

HVA
High Voltage Alarm.  

HVD#
Array High Voltage Disconnect control channel number’s - Three HVD control channels, set points for disconnect and reconnect voltages. These set points are further modified by the battery temperature compensation function of the controller.

I/O
Input/Output - Used in describing the inputs and outputs of the controller.

LED
Light Emitting Diode - A red, green, or yellow solid state light source provided for indication of control and alarm states.

LHVD
Load High Voltage Disconnect.
LVA
Low Voltage Alarm.

LVD#
Low voltage Disconnect number - A set of two LVD disconnect and reconnect set points.
MOV
Metal Oxide Varistor - A metal oxide semiconductor device used to absorb transient voltages and currents.

PV
Photovoltaic

SOC
State Of Charge - The percentage of the original fully charged battery.

TRANSORB
A trade name for semiconductor device used to absorb transient voltages.

UL
Underwriters Laboratory - A safety standards organization in the United States that sets safety standards for electrical equipment.

VRLA
Valve Regulated Lead Acid - A type of sealed battery.  The GNB Absolyte IIP line is a typical VRLA battery.

LCD
Liquid Crystal Display - Refers to the two-line digital display of the MPR controller.

LEVEL
Refers to the structure of the WINDOWS used to program the operation of the MPR controller.

WINDOW
Refers to a specific LCD display.

FIELD
The location of a programmable parameter located in the bottom line of the LCD;s Window. Each firld is selected using the “Field” Key.

FUNCTIONS
The MPR-9400 controller performs the following functions:

1. Storage battery charge management using 1 to 3 PV sub-array input control channels. (HVD1 to HVD3) LCD indications of the HVD channel states NOTE: THE MPR-9400 CAN BE CUSTOMIZED TO MEET LARGER SYSTEMS WITH MORE THAN 3 SUB-ARRAYS. PLEASE CONTACT DST. Individual set points for each channel plus set points and programming for battery equalization and battery temperature compensation.

2. Storage battery discharge management with prioritized load set points, LVD1 and LVD2. LCD indications of the LVD channel states, remaining load hours, high voltage load disconnect and time of day ON/OFF of Load disconnect/reconnect.

3. IF INSTALLED: Control of load voltage by the CEMF (Counter Electro Motive Force) technique that uses a series of voltage drops using diodes to regulate system output voltage.

4. System status indication by LEDs, LCD screen and 232 port.

5. Nominal voltages- 12,24,36,48,60,72,84,96,108,120 VDC.
6. Alarms for battery Low Voltage and High Voltage with SPDT relays rated at 5A with LED indication of alarm status.

7. Positive, negative or floating ground.

8. Remote battery temperature sensors for temperature compensation of HVD’s and generator control.

9. Internal controller temperature sensor.

10. Analog backup of HVD and LVD with LED indication of backup system Controller failure. “CHECK SYSTEM” LED.

11. Viewing of metering, control channel states plus programming capability using the LCD and Keyboard, local Portable Computer, Remote access by dial-up telephone modem, GSM modem and Ethernet interfaces.

12. Diode protected from reverse polarity.

13. Lightning/surge/static protection via MOVs and transorbs.

14. Accumulation and display of PV, Generator/rectifier, Wind and Load Amp-Hours, minimum and maximum voltages, current and temperature readings with time and date stamp of the event.
15. The Data Logging option provides 1, 5, 15, 30 or 60 minute sampling periods that stores all of the MPR-9400’s analog and digital readings during the sampling period.  
16. Digital alarm detection inputs for, Generator and rectifier faults. (Customizable)

17. Input for monitoring of solar irradiance.

18. Self correcting firmware, watchdog fault resets.

CONTROLLER POWER RATINGS
1. The ratings of the power input and output circuit capacities are the maximum current ratings of the circuit breakers and relays installed.

2. PV circuit breakers and Normally Open mercury displacement relays are typically rated at 30, 60 or 100 Amps, depending on the controller’s configuration.

3. Load circuit breakers and Normally Closed mercury displacement relays are rated at 30, 60 or 100 Amps, depending on the controller’s configuration.

4. IF INSTALLED: 1 to 3 CEMF channels, NC relays rated at 30, 60 or 100 Amps.

NOTE: As required by the National Electric Code (NEC), a de-rating factor of 1.56 must be applied to all input charging source circuits. Therefore, the maximum NEC short circuit array current for each 100 amp array input circuit is 64 amps.  
LED/LCD/KEYPAD INSTRUMENT PANEL:


LED-LCD KEYPAD INSTRUMENT PANEL

CONTROLLER OPERATION

POWER INPUT CONTROL AND MONITORING FUNCTIONS.
DST’s EBBM™ charge algorithm (amp hour counting) OR Voltage mode, charges the batteries with the ability to program the HVD set points recommended by the battery manufacturer. The charging is accomplished using 1 to 3 sub-arrays to Bulk charge, taper and finish charge the batteries. HVD1, 2 and 3 will sequentially disconnect HVD3 first, HVD2 second. HVD1 will then finish charge the battery by pulsing the #1 sub array.  When the charging is complete, all arrays are disconnected until a programmed HVD’s battery voltage reconnect voltage setting is reached. The sub array charging is controlled by normally open MDRs (mercury displacement relays). In the case of controller failure the Array charging will be interrupted to avoid damage to the batteries by over charging.
HVD, HVA and Analog Backup

In the event of a high voltage alarm, the HVA LED will illuminate and the HVA relay will engage to alert of a battery over voltage condition. In an extreme over voltage condition the analog back up circuit will disconnect the PV arrays and provide a “Check System” LED alarm.  The analog back up is an analog circuit that will override the digital circuit.

Input Current Monitoring
Input current is sensed through PV, Rectifier and Wind current shunts and displayed on the LCD.  These current input values are factored into cumulative Amp-Hour calculations for each of the respective charging sources.
HVD1 to HVD3 - Staged Array Control

Arrays #2 and #3 HVD Disconnect/reconnect set points MUST be lower than Array #1 HVD disconnect/ reconnect set points to accomplish proper taper charging. 
Temperature Compensation

Temperature compensation is applied to the HVD and generator set points. The temperature range that the compensation is enabled is programmed by setting the low and high temperature ranges.

If the Temperature sensor is disconnected, the controller will revert to 25°C temperature compensation.


Battery Equalization

Automatic or manual Battery Equalization can be enabled or disabled.  Equalization can be accomplished by the use of either the PV arrays or by the generator. Manual equalization or number of days between equalization can be programmed. 
PV EQUALIZATION

In PV equalization mode, after the programmed number of days has elapse between equalization cycles, the arrays will equalize the batteries for one solar day and then revert back to normal HVD settings. During equalization, HVD #1 will pulse to the higher voltage for the number of hours remaining of the solar day. For example; If in equalize mode, and the battery charging is completed by 11:00 AM, the controller will pulse the charge of HVD #1 for the remaining time the sun is providing energy for that day.
GENERATOR EQUALIZATION

In generator equalization mode, after the programmed number of days elapse between equalization, the generator will start and run for the programmed equalization hours.

See Generator Control Section

POWER OUTPUT CONTROL AND MONITORING FUNCTIONS.

LVD- Low Voltage Disconnect, LVA and Analog Backup

During a low battery voltage condition, Load prioritizing can be accomplished by programming individual setpoints for LVD1 and LVD2 relays. When Load #1 and/or Load #2 discharges the batteries to the programmed LVD set points, the power to the respective load(s) will be interrupted. Prior to reaching the LVD/s setpoints, the LVA (Low Voltage Alarm) will engage to alert of a low battery voltage condition. If a digital control system failure occurs, the Analog back up will disconnect the load(s) from the batteries. 
CEMF CONTROL - IF INSTALLED (Not currently supported on Version PV6.08.06)
CEMF (Counter ElectroMotive Force) is accomplished by regulation of the load voltage output to the Load(s) in 3 stages of CEMF circuits. The circuit consists of three sets of diode drops that are enabled by monitoring the Load voltage. A 48 VOLT SYSTEM- Each stage of the three stages provides a 3 volt drop for a total voltage reduction of approximately 9 volts. As the battery voltage rises above the maximum allowable Load voltage setting, the first diode stage applied. If the battery voltage continues to rise, the second stage will engage and so on. When the battery voltage falls below the minimum allowable Load voltage setting the stages will consecutively be removed.

Output Current Monitoring

Output/Load Current is sensed by the bi-directional shunts and is display on the LCD.  These output currents are integrated for load Amp-Hour monitoring logging.
Load Timing Functions

Daily Load timing of load 1 and Load 2 by setting time of day ON/OFF via LCD/Keypad.

Load High Voltage Disconnect

High battery voltage disconnect of the Load(s).
BATTERY CONDITION MONITORING

Battery Voltage and State Of Charge

Battery Voltage, Battery charging net amps and state of charge are displayed.

Charging and Load Amps

Charging amps and Load amps are displayed.

Battery and Controller Temperature Monitoring

Battery and controller temperatures are displayed.
Load voltage NOT INSTALLED ON THIS CONTROLLER 

Load voltage is monitored after the CEMF diode drop.
OTHER CONTROL AND MONITOR FUNCTIONS

Contact Digital Solar Technologies for your specific requirements.
INSTALLATION

INSTALL THE MPR-9400 CONTROLLER IN ACCORDANCE WITH LOCAL AND/OR NATIONAL ELECTRICAL CODES.

ENVIRONMENT

The MPR-9400 will operate in environmental temperatures from -40°C to 55°C ambient temperatures with humidity to 99% non-condensing. The controller circuitry is designed from -40°C to 85°C.

EXTERNAL CONNECTIONS

Wire Connections- Insure polarity is correct!

Battery

Battery sense wires 

Arrays 

Loads  

Battery Temperature sensor.

LVA, HVA alarm connections

Generator control wiring 

Fault input connections 

Auxiliary Input connections 

Computer/Modem Telecommunication connections

CONNECTIONS SHOULD NOT BE ENERGIZED AT THIS TIME 

INITIAL WIRING PROCEDURE

BE ABSOLUTELY SURE THAT THE WIRES AND POLARITY ARE CORRECT.
EARTH GROUND

During assembly each MPR-9400 is specially configured for operation in either negative or positive grounded applications. Although, either configuration may be used in a floating (un-grounded) application. Controller damage will occur if a negative ground MPR-9400 is connected to a positive ground battery. Likewise controller damage will occur if a positive ground MPR-9400 is connected to a negative ground battery.

Verification of MPR-9400 grounding configuration can be determined by the “P” (positive) or “N” (negative) desigignator in the units Model number.
BATTERY
Connect the battery cables.

Battery Voltage Sense

The MPR-9400 will not accurately monitor the battery voltage unless the battery sense wires are installed! Battery volt sense wiring may have be completed at DST. If so, no field connections are required.
Using 18 to 20 AWG (1mm to 2mm), run the sense wires from the battery to the controller’s I/O card, or optional terminal block if installed, and connect to “BATT SENSE” A & B” NOTE: “B” IS ALWAYS SYSTEM GROUND! THERE MUST BE A 2 AMP FUSE INSTALLED ON THE NON-GROUNDED CONDUCTOR. We recommend removing this fuse during initial wiring. Replace after verification of proper polarity before powering the controller.

PV ARRAYS

Connect the non grounded array cables to the array circuit breakers. Circuit breakers to be in the OFF position. 

Connect the array ground cables to the ground bus. 

Connect the non grounded Load(s) cables to the Load circuit breakers. Circuit breakers to be in the OFF position. 

Connect the Load(s) ground cables to the ground bus.

CONTROLLER START UP AND PROGRAMMING 
TURN “ON” THE SYSTEMS BATTERY DISCONNECT

View the LCD display - Bat: Amps, Volts and %SOC”. To change the LCD’s contrast, press and hold the Keypad’s LCD key until the desired brightness is achieve

LED INDICATORS

NOTE: 
ALL OF THE RELAY AND ALARM CONDITION STATES ARE ALSO INDICATED IN THE LCD LEVEL 0 Windows.

1. The Green LOAD LED is the Load #1 ON/OFF indicator. This LED will turn ON when Load #1 is connected and will turn OFF when the LOAD #1 is disconnected. Turning OFF the Load circuit breakers will not disable the load control circuit, therefore the LED will remain ON.

2. The Yellow LOW VOLTAGE ALARM (LVA) LED will turn ON when the LVA set point has been reached and will turn OFF when the reconnect voltage set point has been reached.

3. The Yellow MAX (Arrays OFF) LED indicates that HVD1 and all sub arrays are disconnected.

4. The Red HIGH VOLTAGE ALARM LED will turn ON when the HVA ON set point has been reached and will turn OFF when the HVA OFF set point is reached.

5. The Green GENERATOR LED will turn ON when the controller is instructing the generator to run and will turn OFF when the controller instructs the generator to turn OFF.

6. The RED CHECK SYSTEM LED will turn ON when the Analog Back Up system is activated indicating a very high or very low voltage condition. OR the battery sense wires are connected in the wrong polarity.
The LCD AND KEYPAD OPERATION

The LCD and Keypad are provided to view information and change control functions and set points. Using the Keypad and viewing the LCD Windows structure is described below.
KEYPAD FUNCTIONS

The Keypad consists of nine tactile membrane switches. SET, CLEAR, LCD, LEVEL, FIELD, UP arrow, Down arrow, Left arrow and Right arrow. If a key is depressed momentarily the function is activated once. If a key is held in the depressed position, the function is activated repeatedly.

The LCD key is used to lighten or darken the characters contrast. IF this key has not been pressed for 4 second, the direction of contrast reverses. For instance, if repeated presses are lightening the display, pausing for 4 secondS will cause the next key press to darken the display. If the display reaches the darkest or lightest setting, it will reverse direction.

The level key is used to access the various LEVEL.


The RIGHT ARROW key moves to the next higher WINDOW in a LEVEL.  IF the last WINDOW on a LEVEL is visible and the key is pressed, then the display returns to the first WINDOW.


The LEFT ARROW key moves to the next lower WINDOW on a LEVEL.  If the first WINDOW on a LEVEL is visible and the KEY is pressed, then the display goes to the last WINDOW on that LEVEL.


The UP ARROW key increases the VALUE or SETTING in a FIELD.  The key is disabled if the LEVEL is locked. If the FIELD is a VALUE, this key increases the numerical value. When the highest value is reached, the value loops around to the lowest value. If the field is a SETTING, the FIELD goes to the next setting in the available list. After the VALUE or SETTING is changed, the SET key must be used to program the change(s).
The DOWN ARROW key decreases the VALUE or SETTING in a FIELD.  It functions like the UP ARROW key.




The Set key is used to program new value’s or setting’s to the systems memory. It is also used to reset the data memory and to unlock access to Levels. A new value or setting is not recorded in memory until the Set key is pressed. After the Set function is completed the Clear key must be pressed.

The Clear key is used to cancel any changes to value’s and settings before the Set key is pressed. 
The FIELD key moves the CURSOR under the variables in the bottom LCD line. This key only works if the CURSOR is visible, that is, a correct LOCK NUMBER has been entered to unlock the LEVEL and allow programming changes.
MPR-9400 VERSION 6.08.06 LCD WINDOWS


All LCD windows have a top and bottom line. The top line is used to describe the type of information provided and the bottom line indicates the values, states, set points etc.

LEVEL 0 Windows

Level 0 Windows display real time metering values, voltages, currents, alarms, etc. The information displayed on the bottom lines are real time values updated every 1 second.

A blinking * is displayed in every Level 0 Window. It is located on the very left of the bottom line. The blinking indicates that the processor is operating and the values displayed are being updated. If the * is not blinking, the processor is locked up and not functioning. 

LEVEL 0 WINDOW 0


LEVEL 0 WINDOW 1


LEVEL 0 WINDOW 2


LEVEL 0 WINDOW 3


LEVEL 0 WINDOW 4


LEVEL 0 WINDOW 5


SEE Generator Control Section

LEVEL 0 WINDOW 5b


SEE Generator Control Section
LEVEL 0 WINDOW 6


SEE Generator Control Section
LEVEL 0 WINDOW 7


LEVEL 0 WINDOW 8


The Tot value is today’s total Amp Hours supplied to the system’s Loads. This value is calculated by monitoring the Load shunt circuit plus the PV, Rectifier and Wind shunt circuits. NOTE: The PV, Load, Rectifier and Wind shunt circuits are bi-directional, therefore all are capable of monitoring either input or output amperages.  
LEVEL 0 WINDOW 9


The Tot value is today’s total Amp Hours supplied to the system. This value is calculated by monitoring the PV shunt circuit plus the Load, Rectifier and Wind shunt circuits. NOTE: The PV, Load, Rectifier and Wind shunt circuits are bi-directional, therefore all are capable of monitoring either input or output amperages.  
LEVEL 0 WINDOW 10


LEVEL 0 WINDOW 11


LEVEL 0 WINDOW 12


The Tot value is the total Amp Hours supplied to the system’s Loads. This value is calculated by monitoring the Load shunt circuit plus the PV, Rectifier and Wind shunt circuits. NOTE: The PV, Load, Rectifier and Wind shunt circuits are bi-directional, therefore all are capable of monitoring either input or output amperages.  
LEVEL 0 WINDOW 13


LEVEL 0 WINDOW 14



LEVEL 0 WINDOW 15


LEVEL 0 WINDOW 16


LEVEL 0 WINDOW 17


LEVEL 0 WINDOW 17b




LEVEL 0 WINDOW 18

LEVEL 100 - MEMORY LEVEL

Windows in Level 100 display logging of parameters as explained below. 

TODAYS LOGGING

LEVEL 100 WINDOW 100


LEVEL 100 WINDOW 101


LEVEL 100 WINDOW 102


LEVEL 1 WINDOW 103


LEVEL 1 WINDOW 104


LEVEL 100 WINDOW 105


LEVEL 100 WINDOW 106


LEVEL 100 WINDOW 107


LEVEL 100 WINDOW 108


LEVEL 100 WINDOW 109


LEVEL 100 WINDOW 110


LEVEL 100 WINDOW 111


LEVEL 100 WINDOW 112


LEVEL 100 WINDOW 113


LOGGING ACCUMILATION TOTALS SINCE LAST RESET

LEVEL 100 WINDOW 114


LEVEL 100 WINDOW 115


LEVEL 100 WINDOW 116


LEVEL 100 WINDOW 117


LEVEL 100 WINDOW 118


LEVEL 100 WINDOW 119


LEVEL 100 WINDOW 120


LEVEL 100 WINDOW 121   


LEVEL 100 WINDOW 122


LEVEL 100 WINDOW 123


LEVEL 100 WINDOW 124


LEVEL 100 WINDOW 125


LEVEL 100 WINDOW 126


LEVEL 100 WINDOW 127


LEVEL 200 - CONTROL LEVEL

Windows in Level 200 display set points and permits programming of various parameters, as explained below.

LEVEL 200 WINDOW 200

The Lock Number on this Level provides the ability to prevent re-programming of parameters by unauthorized personnel. The Lock Number is set at 00 00 00 at the factory. 

If the Lock Number override jumper is installed on the CPU card P/N MPR-9401-01 on H18 (located above the DB9 connector), anyone can re-program set points etc. 

If this jumper is not installed:

POSSIBLE Scenario’s

1. Lock Number has not been changed from 00 00 00, press SET and CLEAR on the keypad to unlock Level 200.

2. Lock Number has been changed, enter your Lock Number and press SET and CLEAR on the keypad to unlock Level 200.
LEVEL 200 WINDOW 201


LEVEL 200 WINDOW 202


LEVEL 200 WINDOW 203

LEVEL 200 WINDOW 204

LEVEL 200 WINDOW 204b


LEVEL 200 WINDOW 205


The Equalize function raises the battery’s charge voltage in order to “equalize” the cells.

LEVEL 200 WINDOW 205b

LEVEL 200 WINDOW 205c

LEVEL 200 WINDOW 205d


LEVEL 200 WINDOW 206


LEVEL 200 WINDOW 207


LEVEL 200 WINDOW 208


LEVEL 200 WINDOW 209  


LEVEL 200 WINDOW 210  


LEVEL 200 WINDOW 211  


LEVEL 200 WINDOW 212  


LEVEL 200 WINDOW 213  


SEE GENERATOR CONTROL SECTION 

LEVEL 200 WINDOW 214:  


SEE GENERATOR CONTROL SECTION 
LEVEL 200 WINDOW 215:  


SEE GENERATOR CONTROL SECTION 

LEVEL 200 WINDOW 216: 


SEE GENERATOR CONTROL SECTION 
LEVEL 200 WINDOW 216b: 


SEE GENERATOR CONTROL SECTION 
LEVEL 200 WINDOW 216c:

SEE GENERATOR CONTROL SECTION 
LEVEL 200 WINDOW 217:  


SEE GENERATOR CONTROL SECTION 
LEVEL 300 INSTALL LEVEL

LEVEL 300 WINDOW 300


The Lock Number on this Level provides the ability to prevent re-programming of parameters by unauthorized personnel. The Lock Number is set at 00 00 00 at the factory. 

If the Lock Number override jumper is installed on the CPU card P/N MPR-9401-01 on H18 (located above the DB9 connector), anyone can re-program set points etc. 

If this jumper is not installed:

POSSIBLE Scenario’s

3. Lock Number has not been changed from 00 00 00, press SET and CLEAR on the keypad to unlock Level 300.

4. Lock Number has been changed, enter you’re number and press SET and CLEAR on the keypad to unlock Level 300.
LEVEL 300 WINDOW 301 through 303




AUTO mode (factory setting), PV OFF or PV ON. PV OFF and PV ON will override the HVD voltage settings. These set points are also affected by the temperature compensation variable.

LEVEL 300 WINDOW 304


LEVEL 300 WINDOW 305 and 306



AUTO mode (factory setting), LVD’s OFF or LVD’s ON. LVD OFF and LVD ON will override the LVD voltage settings.

LEVEL 300 WINDOW 307


LEVEL 300 WINDOW 307b and 307c









LEVEL 300 WINDOW 309


Temperature Compensation coefficient affects the set points of HVD1,2 and 3 plus the generator’s Von and Voff set points. 

LEVEL 300 WINDOWs 310 and 311



LEVEL 300 WINDOW 313


LEVEL 300 WINDOW 314


LEVEL 300 WINDOW 315


LEVEL 300 WINDOW 316


During the array’s disconnection periods due to no solar input, the arrays will be briefly connected and sample the PV current’s input. If the PV current input is greater than the Dark Protect amperage setting in Window #315, the arrays will continue to be connected and the MPR-9400 will control the charging af the batteries. As described in Windows #301 – 303.

LEVEL 300 WINDOW 317


LEVEL 300 WINDOW 318


LEVEL 300 WINDOW 319


This Set point will instruct the 9400 to communicate by direct cable only (“None”), GSM Modem (“Modem”), Dial-up (“Modem Type2”) or Ethernet (“Ethernet”). 
LEVEL 400 FACTORY LEVEL

LEVEL 400 WINDOW 400


LEVEL 400 WINDOW 401


LEVEL 400 WINDOW 402


LEVEL 400 WINDOW 403


LEVEL 400 WINDOW 404


LEVEL 400 WINDOW 405


LEVEL 4 WINDOW 406


LEVEL 400 WINDOW 407


LEVEL 400 WINDOW 408


This variable sets the battery temperature sensor’s metering factor.

LEVEL 400 WINDOW 409


LEVEL 400 WINDOW 409


PROGRAMMING EXAMPLE

The following example descibes the steps to complete a setting change.

To change the HVD2 set points: Level 3 window 302, HVD2, change the Disconnect and Reconnect voltages. Initially the LCD will be in the default window LEVEL 0 WINDOW 0.


Press the LEVEL key three (3) times; 








Enter password number, if it has been changed from the factory’s setting (00 00 00), Example- password number combination has been changed to- 20 30 40. Press the UP ARROW 20 times or hold down to change the first double digits to 20; 

Now press the FIELD key once to move the cursor, and press the UP ARROW 30 times or hold down until 30 appears; 




Now press the FIELD key once to move the cursor and press the UP ARROW 40 times or hold down as before to change the third set of digits to 40;


NOW PRESS THE SET KEY TO ENTER THE COMBINATION.

Now press the CLEAR key to continue, the following window will appear and will allow the user to change to a new combination number, if so desired.


If required, change the Lock Number as described above.
Now press the RIGHT ARROW to access WINDOW 301;

Now press the RIGHT ARROW one (1) time to access WINDOW 302;

The cursor will be under the HVD2 Mode setting, To change the Disconnect voltage, say to 56.30, press the Field key once to move the cursor to the Disc voltage field. Press the UP ARROW or DOWN ARROW keys until the field contains the desired value. 

NOW PRESS SET KEY ONCE THEN THE CLEAR KEY ONCE;


THE PROGRAMMING IS COMPLETE. Press the Level key to access other levels.
Recommended Settings and Set Points

	LEVEL 2
	TITLE
	VARIABLE(S)
	   
	SETTINGS
	ADDITIONAL INFORMATION.

	WINDOW
	 
	 
	12 V
	24 V
	48
	 

	200
	Enter
	Lock Number
	0
	0
	0
	Customer to Program

	205
	Charge Type
	Normal
	Voltage
	Voltage
	Voltage
	SELECTIONS - NORMAL OR EQU

	205b
	Auto EQU
	Days
	30
	30
	30
	Customer to Program

	 
	 
	TimeOn
	23:00
	23:00
	23:00
	Customer to Program

	205c
	EQU MaxTime
	Hours
	12
	12
	12
	Customer to Program

	205d
	EQU
	Vboost
	0.50
	1.00
	2.00
	Customer to Program

	 
	 
	StopV
	14.5
	29
	58.00
	Customer to Program

	206
	Date
	Year Num.
	 
	 
	 
	Set to Year when manuf.

	 
	 
	Month Numb.
	 
	 
	 
	Set to Month when manuf.

	 
	 
	Day Numb.
	 
	 
	 
	Set to  Day # when manuf.

	207
	Time
	Hours
	 
	 
	 
	Set to Mountain Time Zone

	 
	 
	Minutes
	 
	 
	 
	Set to Mountain Time Zone

	 
	 
	Seconds
	 
	 
	 
	Set to Mountain Time Zone

	208
	Day Of Week
	Day Of Week
	 
	 
	 
	Set to Day of Week

	209
	Load 1 Timer
	Enable/Disable
	Disable
	Disable
	Disable
	SELECTIONS - ENABLE OR DISABLE

	 
	 
	Time On
	0:00
	0:00
	0:00
	Customer to Program

	210
	Load 1 Timer
	Time Off
	0:00
	0:00
	0:00
	Customer to Program

	211
	Load 2 Timer
	Enable/Disable
	Disable
	Disable
	Disable
	SELECTIONS - ENABLE OR DISABLE

	 
	 
	Time On
	0:00
	0:00
	0:00
	Customer to Program

	212
	Load 2 Timer
	Time Off
	0:00
	0:00
	0:00
	Customer to Program

	213
	Gen Mode
	Mode
	Current
	Current
	Current
	Sel- ON,OFF,CURRENT OR TIMED

	 
	 
	Volts On
	12.00
	24.00
	48.00
	Customer to Program

	 
	 
	Volts Off
	14.25
	28.5
	57
	Customer to Program

	214
	Gen
	WaitDays
	0
	0
	0
	Customer to Program

	 
	 
	RunMins
	0
	0
	0
	Customer to Program

	215
	Gen
	Amps Off
	20
	20
	20
	Customer to Program

	 
	 
	Volt threshold
	12.75
	25.50
	51.00
	 

	216
	Gen
	Hours Max
	12
	12
	12
	Customer to Program

	 
	 
	Equ Hours Max
	12
	12
	12
	Customer to Program

	216b
	Gen
	MaintHrsAlarm
	500
	500
	500
	Customer to Program

	216c
	GenFaultDelay
	Seconds
	5
	5
	5
	 

	217
	ACD
	Start Minutes
	0
	0
	0
	Customer to Program

	 
	 
	End Minutes
	0
	0
	0
	Customer to Program

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	LEVEL 3
	TITLE
	VARIABLE(S)
	       
	SETTINGS
	ADDITIONAL INFORMATION.

	WINDOW
	 
	 
	12 V
	24 V
	48 V
	 

	300
	Enter
	Lock Number
	0
	0
	0
	 

	301
	HVD1
	Mode
	Auto
	Auto
	Auto
	SELECTIONS - AUTO, ON or OFF

	 
	 
	Disconnect V
	14.13
	28.25
	56.50
	 

	 
	 
	Reconnect V
	13.73
	27.45
	54.90
	 

	302
	HVD2
	Mode
	Auto
	Auto
	Auto
	SELECTIONS - AUTO, ON or OFF

	 
	 
	Disconnect V
	14.08
	28.15
	56.30
	 

	 
	 
	Reconnect V
	13.68
	27.35
	54.70
	 

	303
	HVD3
	Mode
	Auto
	Auto
	Auto
	SELECTIONS - AUTO, ON or OFF

	 
	 
	Disconnect V
	14.03
	28.05
	56.10
	 

	 
	 
	Reconnect V
	13.63
	27.25
	54.50
	 

	304
	LVD Delay
	Seconds
	2
	2
	2
	 

	305
	LVD1
	Mode
	Auto
	Auto
	Auto
	SELECTIONS - AUTO, ON or OFF

	 
	 
	Disconnect V
	11.35
	22.70
	45.40
	 

	 
	
	Reconnect V
	12.50
	25.00
	50.00
	 

	306
	LVD2
	Mode
	Auto
	Auto
	Auto
	SELECTIONS - AUTO, ON or OFF

	 
	 
	Disconnect V
	11.35
	22.70
	45.40
	 

	 
	
	Reconnect V
	12.50
	25.00
	50.00
	 

	307
	Alarm Delay
	Seconds
	5
	5
	5
	 

	307b
	HVA
	Volts On
	15.20
	30.40
	60.80
	 

	 
	 
	Volts Off
	14.25
	28.50
	57.00
	 

	307c
	LVA
	Volts On
	11.75
	23.50
	47.00
	 

	 
	 
	Volts Off
	12.75
	25.50
	51.00
	 

	309
	Temp Comp Coef.
	mV/cell/C
	-5.5
	-5.5
	-5.5
	 

	310
	Tcomp Range Max
	Degrees C
	50
	50
	50
	 

	311
	Tcomp Range Min
	Degrees C
	0
	0
	0
	 

	313
	BAT
	AH Installed
	500
	500
	500
	Customer to Program

	314
	BAT
	Batt Efficiency
	90%
	90%
	90%
	 

	315
	Dark Protect
	Amps
	1
	1
	1
	 

	316
	Dark Protect
	Minutes
	10
	10
	10
	 

	317
	Charge Mode
	Charge Mode
	Volts
	Volts
	Volts
	SELECTIONS - VOLTAGE OR EBBM

	318
	Logging Minutes
	Minutes
	15
	15
	15
	Customer to Program

	319
	2nd Comm Interface
	Variable
	None
	None
	None
	SELECTIONS - NONE, MODEM, 

	
	
	
	
	
	
	ETHERNET OR MODEM TYPE2

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	LEVEL 4
	TITLE
	VARIABLE(S)
	  
	SETTINGS
	ADDITIONAL INFORMATION.

	WINDOW
	 
	 
	12 V
	24 V
	48 V
	Factory Setting Below

	400
	Digital Solar Tech.
	Firmware Version
	6.08.06
	6.08.06
	6.08.06
	Do Not Changed

	401
	Serial Number
	Serial Number
	 
	 
	 
	Variable- Not to Be Changed

	402
	Volts Nominal
	Volts
	12
	24
	48
	 

	403
	Bat Voltage Calibration
	Cal (Gain)
	240
	240
	240
	Variable- Not to Be Changed

	 
	 
	Zero (Offset)
	0
	0
	0
	Variable- Not to Be Changed

	404
	Load Shunt Calibration
	Cal (Gain)
	78
	78
	78
	Variable- Not to Be Changed

	 
	 
	Zero (Offset)
	128
	128
	128
	Variable- Not to Be Changed

	 
	 
	Shunt Size
	100
	100
	100
	Variable- Not to Be Changed

	405
	PV Shunt Calibration
	Cal (Gain)
	78
	78
	78
	Variable- Not to Be Changed

	 
	 
	Zero (Offset)
	128
	128
	128
	Variable- Not to Be Changed

	 
	 
	Shunt Size
	100
	100
	100
	Variable- Not to Be Changed

	407
	Rect. Shunt Calibration
	Cal (Gain)
	78
	78
	78
	Variable- Not to Be Changed

	 
	 
	Zero (Offset)
	128
	128
	128
	Variable- Not to Be Changed

	 
	 
	Shunt Size
	100
	100
	100
	Variable- Not to Be Changed

	408
	Wind Shunt Calibration
	Cal (Gain)
	78
	78
	78
	Variable- Not to Be Changed

	 
	 
	Zero (Offset)
	128
	128
	128
	Variable- Not to Be Changed

	 
	 
	Shunt Size
	100
	100
	100
	Variable- Not to Be Changed

	409
	Batt Temp Calibration
	Cal (Gain)
	0
	0
	0
	Variable- Not to Be Changed

	410
	Unit Temp Calibration
	Cal (Gain)
	0
	0
	0
	Variable- Not to Be Changed

	411
	Sun Calibration
	Cal (Gain)
	160
	160
	160
	Customer to Program

	
	
	
	
	
	
	

	
	
	ADDITIONAL SETTINGS BY MPRCOMM ONLY
	

	
	
	
	
	
	
	

	LEVEL
	TITLE
	VARIABLE(S)
	  
	SETTINGS
	ADDITIONAL INFORMATION.

	FACTORY
	Site Name
	NA
	Blank
	Blank
	Blank
	Customer to Program

	 
	Modem Init String
	Modem Init Str
	 
	AT&FE0X0V0S0=1
	 
	Not to Be Changed

	 
	SNMP Address
	IP Address
	 
	 
	 
	Customer to Program

	 
	Dialout Tele. #
	Dialout Tele. #
	Blank
	Blank
	Blank
	Customer to Program

	 
	Alarms Button
	Alarm Send
	 
	 
	 
	Alarm send out ON or OFF

	 
	 
	LVA
	ON
	ON
	ON
	Customer to Program

	 
	 
	HVA
	ON
	ON
	ON
	Customer to Program

	 
	 
	Gen1 Running
	ON
	ON
	ON
	Customer to Program

	 
	 
	Gen1 Raw
	ON
	ON
	ON
	Customer to Program

	 
	 
	Gen1 Fault
	ON
	ON
	ON
	Customer to Program

	 
	 
	Gen1 Low Curr
	ON
	ON
	ON
	Customer to Program

	 
	 
	LVD1
	ON
	ON
	ON
	Customer to Program

	 
	 
	LVD2
	ON
	ON
	ON
	Customer to Program

	 
	 
	Gen Hrs Alarm
	ON
	ON
	ON
	Customer to Program

	 
	 
	Fault2/GEN Running
	ON
	ON
	ON
	Customer to Program


MPR-9400 V6.8.6 GENERATOR CONTROL   

GENERATOR STATUS:

LEVEL 0 WINDOW 5


This window indicates the current state of the Generator (‘Off’ if the generator is not running, or ‘On’ if the generator is running), and the state of the AC Delay function (channel #9 on the I/O card). The AC Delay function allows for a generator “warm-up” and “cool-down” period, during which times the generator is running but it is not connected to the load. See Window 217 for more information regarding the AC Delay function. Also indicated in Window 5 is the number accumulated generator run hours and minutes since the last time the Gen Hours were reset. NOTE: In order to support the warm-up and cool-down functions, an external N.O. relay is required between the generator and rectifiers, OR between a DC generator and batteries. 

LEVEL 0 WINDOW 5b

This window indicates the type of fault last encountered for the generator. Also indicated is the state of the Generator Hours Alarm. The Generator Hours Alarm is active if the generator has run for a greater or equal period of time than the Maximum Generator Maintenance Hours specified in Window #216b.

LEVEL 0 WINDOW 6


This window shows the status of the two fault inputs (channel FLT1 on the I/O card) and Fault Channel 2 (channel FLT2 on the I/O card). Note that the MPR can be programmed to ignore brief “GenFault” signals, and that this window merely shows the states of the inputs, (see Window 216c).

GENERATOR SETTINGS:

LEVEL 200 WINDOW 204


This window allows the user to reset the accumulated generator hour totals. Doing this will also clear the Maintenance alarm, if activated.

LEVEL 200 WINDOW 204b


This window allows the user to reset the last reported error condition for the generator. Note that if a generator error condition has occurred, a “Reset Gen Error” must be performed, otherwise the generator will always remain off.

LEVEL 200 WINDOW 213 

This window allows the user to set the generator control mode, (Gen-Off, Gen-On, Timed, or Current), as well as voltage thresholds for starting and stopping the generator.

Gen-Off MODE CONTROL DETAILS:

1. When the Gen “OFF” is selected in Window 213, the generator will never be instructed to run by the 9400 control.

2. If the generator is running and the user switches to “Gen-Off” mode, the generator will shut down. If the AC Delay end minutes in Window 217 is set to other than “0”, the ACD signal will turn OFF, the generator will continue to run for the number of minutes (”EndMin”) and then the generator will be instructed to stop. 

Gen-On MODE CONTROL DETAILS:

1. Upon powering up, or after a previous generator run, the generator will always remain OFF for 1 minute.

2. When “Gen-On” is selected in Window 213, the generator will be instructed to start and will be instructed to connect to the rectifiers after the “StartMin” setting in Window 217 (ACD) has elapsed. An external relay is required to fully support this function, see Window 217 for details.

3. Gen Fault (FLT1), if activated, will turn off the generator and will not restart it until the fault is reset.

4. The generator will continue to run. Note that reaching the “Voff” set point in Window 213 will not stop the generator. Keep in mind that staying in “Gen-On” mode too long can potentially damage the batteries!

5. When the “HrMax” setting in Window 216 has expired the ACD signal will turn off. If the ACD “EndMin” setting is greater than zero, the generator will continue to run for the additional cool-down time specified by “EndMin”, (see Window 217).

6. If the total minutes of run time for this run is less than the value in “RunMins”, (window 214), the generator will continue to run until it has been on for the minimum amount of time specified.

7. The generator will turn off, then restart after one minute, (see step 1. above).

TIMED (Voltage) MODE CONTROL DETAILS:

1. Upon powering up or after a previous generator run, the generator will always remain OFF for 1 minute.

2. The generator will start if the temperature compensated battery voltage is less than or equal to “Von” in window 213, or if it is time for a maintenance run, (see window 214).

3. If the Gen Fault (FLT1) input is activated, the generator will turn off and not restart until the fault is reset, (see window 204b). The Gen Fault input (FLT1) can be programmed to ignore brief pulses, (see window  216c).

4. The controller will wait for the number of minutes specified in “StartMins”, (see window 217). The ACD signal will then turn on.

5. The generator will run until the temperature compensated battery voltage is greater than or equal to “Voff”, or the generator has run for the numnber of hours specified in the “HrMax” setting, (see window 216).

6. The ACD signal will turn off, and the generator will continue to run for the number of minutes specified in “EndMins”, (see window 217).

7. If the total minutes of run time for this run is less than the value in “RunMins”, (window 217), the generator will continue to run until it has been on for the minimum amount of time specified.

8. The generator will turn off, then restart after one minute, (see step 1. above).

CURRENT MODE CONTROL DETAILS:

1. Upon powering up or after a previous generator run, the generator will always remain OFF for 1 minute.

2. The generator will start if the temperature compensated battery voltage is less than or equal to “Von” in window 213, or if it is time for a maintenance run, (see window 214).

3. If the Gen Fault (FLT1) input is activated, the generator will turn off and not restart until the fault is reset, (see window 204b). The Gen Fault input (FLT1) can be programmed to ignore brief pulses, (see window  216c).

4. The controller will wait for the number of minutes specified in “StartMin”, (see window 217). The ACD signal will then turn on.

5. The generator will run until the temperature compensated battery voltage is greater than or equal to “Voff”, or the generator has run for the numnber of hours specified in the “HrMax” setting, (see window 216).

6. Additionally, if the rectifier current falls below the amps specified in “Aoff”, (window 215), then the battery voltage will be compared to “Vthr” in window 215. If the battery voltage is above the “Vthr” value, then the generator will begin a normal shutdown sequence. If, however, the battery voltage is below the “Vthr” setpoint, (and the rectifier amps is also below the “Aoff” setpoint, then this will be considered an abnormal condition, and the generator will immediately shut down, see “LowCurr” fault below.

7. The ACD signal will turn off, and the generator will continue to run for the number of minutes specified in “EndMins”, (see window 217).

8. If the total minute of run time for this run is less than the value in “RunMins”, (window 214), the generator will continue to run until it has been on for the minimum amount of time specified.

9. The generator will turn off, then await the next turn on cycle, (see step 1. above).

GENERATOR FAULT CONDITION DETAILS:

GEN FAULT SIGNAL – Any time the generator is running.

1. The generator has provided a voltage free contact closure signal to the FLT1 input on the 9400s I/O card.

2. When this occurs, the 9400 has been instructed that there is a major problem with the generator and will stop the generator, report a “GenFault” in Window #5b and will not try to start the generator until the Gen Error is reset in Window 204b.

3. The Gen Fault input (FLT1) can be programmed to ignore brief pulses, (see window  216c).

LOWCURR – ONLY IN “Current” Mode - 

1. The current is ignored until 30 seconds after the ACD signal turns on. For systems that have an external delay after a generator start before providing current, setting the “StartMin” value can be used to prevent this external delay from causing a LowCurr fault.

2. If the Rectifiers(Gen) current is below the “Aoff” setting, and the battery voltage is below the “Vthr” settings programmed in Window #215, the 9400 will stop the generator, wait 1 minute and re-start the generator.

3. The MPR will repeat the previous cycle. If same condition occurs again, (current is below the “Aoff” setting, and the battery voltage is below the “Vthr” setting), the 9400 will stop the generator, wait 1 minute and re-start the generator.

4.  The MPR will repeat the previous cycle one final time. If same condition occurs a third time, (current is below the “Aoff” setting, and the battery voltage is below the “Vthr” setting), the 9400 will stop the generator and report a “Low Curr” fault condition in Window 5b.

5. When this occurs, the 9400 has determined that there is a problem with either the generator or rectifiers and will not attempt to start the generator again until the Gen Error is re-set in Window 204b, therefore, the “Aoff” setting in Window #215 is critical.

6. It takes three “bad” generator runs in a row to generate a “LowCurr” fault. If, for instance, a low current condition is seen on a run, but the next run finishes normally. Then no fault condition will occur.
OTHER GENERATOR CONTROL DETAILS: 

In the generator Von/Voff control, the generator/rectifier OR DC generator must be able to charge the batteries to a voltage above the “Voff” set point in Window #213. Be aware that the batteries can be damaged if charged to a higher voltage than the battery manufacturers recommended high voltage limit! 

· In window #213, set mode to “Timed”

· Set the “HrMax” in Window #216 to maximum number of hours of each generator run as required.

· Set the “RunMin” in Window #214 to program the minimum time the generator will run during each cycle. If the battery voltage rises to the “Voff” setting before the “RunMins” time setting has elapsed, the generator/rectifier will continue to run until the “RunMins” has expired.

LEVEL 200 WINDOW 214:  


This window sets the Wait Days and minimum Run Minutes for generator maintenance run cycles.

1. If “WaitDays” is set to zero, then the maintenance run function will be disabled.

2. If “WaitDays” is set to 1, then the generator will automatically start each day at midnight.

3. If “WaitDays” is set to 2, then the generator will run at midnight if no generator run occurred on the previous day.

4. If “WaitDays” is set to 3, then the generator will run at midnight if no generator run occurred during the previous 2 days, etc.

“RunMins” specifies the minimum run time for a generator run. Once the generator has started, it will always run for at least the amount of minutes specified in “RunMins”. 
LEVEL 200 WINDOW 215:


When the Gen:Mode is programmed to “Current” mode in window 213, this window allows the user to turn off the generator when the generator/rectifiers charging amperage tapers down to the Aoff setting. The “Vthr” setting is the Threshold Voltage of the battery that must be reached when the current has tapered down. In Current mode, the generator will turn off if the following conditions are simultaneously met:

· The Generator Amps drops below the level specified by the Aoff parameter.

· The Battery Volts exceeds the voltage specified in the Vthr parameter.

· SEE GENERATOR CONTROL DETAILS IN WINDOW #213!
LEVEL 200 WINDOW 216: 

This window allows the user to set the maximum run hours of generator during each cycle. Note that setting this value too low may prevent a generator run from fully charging the batteries.

LEVEL 200 WINDOW 216b: 


This window allows the user to set the maximum hours that the generator may run before the Generator Maintenance Alarm (Level 0, Window 5b) is asserted. Note that a Maintenance Alarm has no effect on generator operation, and is only meant to remind a user that it is time to service the generator, (oil filter change, etc).

LEVEL 200 WINDOW 216c:

This window allows the user to set the number of seconds to delay before reacting to the a generator fault signal (FLT1). This is useful for filtering brief “spikes” which would otherwise cause a generator fault condition. For instance, if the fault delay is set to 5, then a 4 second pulse on FLT1 would be ignored and would not cause the generator to stop.

LEVEL 200 WINDOW 217:  


This window allows the user to set the Start and End Minutes for the AC Delay function. The Start Minutes determines the interval between the time the generator is activated and the time the Rectifiers/load is connected to the generator. This allows for a “warm-up” period before the load is connected to the generator. The End Minutes determines the interval between the time the load is disconnected from the generator and the time the generator is stopped. This allows for a “cool-down” period before the generator is stopped.

The warm-up/cool-down sequence requires a N.O. relay to be installed between the generator and rectifiers. Channel 9 on the I/O card is provided to control this external N.O. relay. Channel 9 is a relay coil driver, therefore, connect the “A” and “B” terminals across the relay coil. “A” is battery posistive and “B” in battery negative.

MPRCOMM COMMUNICATIONS SOFTWARE INSTRUCTIONS

Getting Started with the MPR-9400 MPRCOMM Software

These instructions assume you have a basic understanding of the Windows operating system

Hardware and Software Requirements

To use MPRCOMM, you need the following system software and equipment:

· A Pentium-class PC, running Microsoft Windows.

· Color monitor capable of displaying a screen resolution of 800x600 or greater

· Printer

· To communicate locally with a MPR-9400 unit you must have a standard (straight-through wired) “modem cable” – Male/Female.

· Either an internal or external modem OR Ethernet on your PC.

· START COMPUTER SO IT IS RUNNING UNDER WINDOWS

Installing MPRCOMM for the first time
1.
Start computer so it is running under Windows.

2.
Execute the “MprComm-nnn.exe” program from the root folder of your installation CD (the “nnn” represents the numeric version number of the software installer). The MprComm-nnn.exe program is a self-extracting archive which will automatically launch the MPRCOMM software installer.

3.
Follow the on-screen instructions to install the software. You may choose a custom drive and path for the software if you wish (default installation location is C:\MprComm.

4.
When the installation is complete, you may be prompted to restart your computer.

5.
Execute the program via the MPR-9400 shortcut by selecting it from the Programs menu. 
Note about upgrading existing MprComm installations
If an older version of MprComm has been installed on your computer and you would like to upgrade to a newer version, the procedure is much the same as the procedure for a new installation, with the following differences:

1. The existing version of MprComm will need to be uninstalled before installing the new version of MprComm. You may uninstall the existing software using the Add/Remove Programs function in the Windows Control Panel. Alternately, if you run the “MprComm-nnn.exe” setup program for the new mprComm version, it will automatically detect the existing installation and prompt you to uninstall it. See an important note in (2) below prior to uninstalling the existing software.

2. It is important to note that the MprComm database will be removed during the uninstall process. The MprComm database includes information about any installed Maps and Site icons. If you would like to upgrade the MprComm software, but you would like to keep your existing Maps and Sites, it is necessary to back up the MprComm database prior to uninstalling the software. To back up the database, use the Windows file explorer to make a copy of the “Comm.mdb” file in the MprComm installation folder (the MprComm installation folder is usually C:\MprComm). After you have installed the new MprComm software version, you may restore the database file in the MprComm installation folder (which was replaced with a blank copy during the reinstallation process) by replacing the Comm.mdb file with your backup copy.

3. Once the previously-existing version of MprComm has been uninstalled, execute the “MprComm-nnn.exe” program to install the software. Proceed as indicated in the “Installing MprComm for the first time” section above.

Local Communications Connection for the first time

1. Connect the modem cable to the serial port on your computer

2. Connect the other end of the cable to the DB9- RS232 port located on the MPR-9400 PCB (only if a modem is not installed) or the DB9 port on the modem/Ethernet card located on the back of the instrument panel.

3. Run the MPRCOMM by selecting the MprComm program from the Programs menu.

4. Select the menu "Tools" and click on the "Options" submenu. See Screen figure #7 and #8A through #8B. In the “General” Settings screen (Figure #8A), the “Demo Mode” setting places the software in demonstration mode. Please ensure that the Demo Mode option is unchecked for normal program operation. In the “General” tab (figure #8A), ensure that the “Direct Cable” option is selected, if you are attempting to connect to the MPR unit via a direct serial cable.

5. In figure #8B (the Modem/Network Settings screen), you may select your modem, or enter the phone number or IP address of the MPR unit (if you are connecting via the modem or Ethernet communication options). 

6. Select "OK" to accept the parameter changes. You may be asked to restart the program for the changes to take effect.

7. Click the “Connect” toolbar button to establish a connection to the MPR unit.

NOTE:
After the communication settings have been configured the first time, in the future you may simply click on the “Connect” toolbar button to connect to the MPR unit. 

Remote Modem Communications Connection

1. Run the program

2. If you have already configured the software for modem communications, skip to step 4. Otherwise, select the menu "Tools" and select the "Options" submenu. Click on the “Communication” tab of the Options dialog. See figure #7 and #8B. On figure #8B, select your modem from the drop-down list. Click “OK” to save these settings. You may be asked to restart the program for the changes to take effect.

3. From the “General” tab of the Options dialog, select “Modem” as your default connection method. Close the Options dialog, then click the “Connect” button on the toolbar. In the dialog box that appears, enter the telephone number of the MPR unit you wish to connect to (this number will be saved between program sessions). Click “OK” to attempt a remote modem connection to the MPR controller.

4. If you have a speaker on your modem you will hear the “HAND SHAKING” of the two modems. The “CONNECTION TO REMOTE” will appear the comm. software will download the MPR’s  information. If you experience an ERROR message, click the “Disconnect” button to hang up the modem. If problems persist, you may wish to update your modem driver via the Windows Control Panel.

5. To disconnect the telephone, use the "Hang up" command under "Connections"

NOTE:
After the communication settings are correct and saved, in the future you can SIMPLY click the “Connect” button on the toolbar to establish a modem connection. 

The MPR-9400 information levels

After the controller's information is downloaded, the screen will now show the “Status” level information.

To view the individual levels, use the toolbar buttons to select the various information levels (Memory, Factory, Install, Controls). See Screen Figures #3,9,10,11,12 and 13.

To change settings in levels “CONTROLS”, “INSTALL” and “FACTORY”, you must first “UNLOCK” the level (a “Security” screen will appear automatically the first time you attempt to open any of these screens). After the lock number is entered select “OK”. See Screen Fig. #5. THE COMBINATION LOCK NUMBERS FOR “CONTROL” AND “INSTALL” LEVELS ARE 00 00 00 BY DEFAULT, AND THE COMBINATION NUMBER FOR THE FACTORY LEVEL IS 1 2 3 BY DEFAULT. DO NOT CHANGE ANY CALIBRATION FACTORS IN THE “FACTORY” LEVEL UNLESS ABSOLUTELY NECESSARY! THIS “FACTORY” LEVEL NUMBER SHOULD BE USED ONLY TO ENTER THE DIALOUT TELEPHONE NUMBER (FOR THE AUTOMATIC CALL OUT ON ALARM FUNCTION), THE SITE NAME, OR THE SNMP ADRESS (FOR NETWORK ALARM SENDOUTS, IF ENABLED FOR YOUR HARDWARE)!

When the level desired is unlocked, you can change settings by using your mouse to click the up or down spinners next to each parameter. Note that you may hold down the Shift key while clicking the Up/Down spinner to adjust a parameter in increments of 10, or hold down the Control key to adjust in increments of 100. Also note that many fields allow direct 

keyboard entry of numeric values (click on the value you wish to change to highlight the field, then type the desired value). Once you change the setting, press Enter or click the on-screen “S” button to send the change to the MPR-9400 controller.

OTHER FUNCTIONS OF THE COMMUNICATIONS PROGRAM

Updating the data while you are connected to the controller

The Refresh button in the STATUS screen will only update the data in the Status screen!

DOWN LOADING AND SAVING THE DATA LOG REPORT –

DATA LOGGING CAPACITY

MPR-9400’s number of day’s storage at the sample rates programmed:

1. 1 MIN – 45 DAYS

2. 5 MIN – 225 DAYS

3. 10 MIN – 677 DAYS

4. 30 MIN – 1354 DAYS

5. 60 MIN – 2708 DAYS

DOWNLOAD TIME OF A FULL 2 MB OF MEMORY BUFFER BY DIRECT CABLE IS APPROXIMATELY 45 MINUTES. THE DOWNLOAD TIME VIA MODEMS AND ETHERNET MAY BE LONGER.
SEE BELOW UNDER THE FIGURES #14 and 15.

LOAD DATA LOG REPORT

To view previously save DATA LOG Reports, SEE FIGURES #14 and 15.

AUTOMATIC MPR-9400 CALL OUT

The MPR-9400 will automatically call the host computer if the call out on alarm is enabled in level 200- #211. The alarm information received by the base station computers will be as follows.

The following Call Out Alarm Schedule is the cross reference for the down loaded information the MPR-9400 will provide to the Base station computers upon ALARM CALL OUT. ALARM CALL OUT MUST BE ENABLED IN LEVEL 200!

The communication software must be in “AUTO-ANSWER MODE”- select under “Tools” menu. Leave in “Auto-Answer Mode” when unattended!

The downloaded information will appear as an alarm report screen describing the fault condition. This screen will have a red background.

COMMUNICATION SOFTWARE FUNCTIONALITY AND WINDOW DESCRIPTIONS

Upon booting the program, the window will appear as in figure #1. 

You may select type of connection to attempt via the “Options” screen (accessed under the “Tools” menu). Direct Cable Connection is used for a local connection to the RS232 port via a modem cable, Modem Connection is used for a remote connection using your PC’s modem and telephone line. The “Network” option accommodates TCP/IP connections via LAN (Local-Area Network) or internet. 
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Figure #1

PULL DOWN MENUS

Figure #2 shows the “File” pull down menu;

Manage Maps – Select this option add new map images to the MprComm software, or to select a previously-added map image for display. See the “Installing a new map” section below for more information.

Display Log File - This command allows you to view previously saved log data. This command will only open up MPRCOMM data files. See “Download Log File”. Once you have selected a previously-saved log file from the file-browser dialog, the file’s contents will be displayed in tabular format. See screen figure #14. Once the file information is displayed in tabular format as in figure #14, you may then press the “Graphs” toolbar button to display the same information in graphical format (see screen figure #15)

Export Log File – Select this option to export a previously-saved Log file to a text file. The file is formatted as an ASCII tab-separated text file, suitable for import into many application such as Microsoft Excel or Access.

Save Unit Data – Select this option to save the current settings of the MPR controller. This is useful if you wish to backup your current settings, or if you wish to upload the same settings to another unit.

 

Upload Unit Data – Select this option to upload previously-saved unit settings to an MPR unit.

Export Unit Data File – Select this option to export a previously-saved unit data file as an ASCII text file.

Preview Report - This will display to the screen a report of the current MPR unit settings and real-time parameters (voltages, currents, accumulated amp-hours, etc)

Print Report - This command will print a hardcopy report of the current MPR unit settings and real-time parameters (voltages, currents, accumulated amp-hours, etc)

Set Point Report – This command will generate a report of all of the settable parameters for the MPR controller. The report includes the parameter names, LCD window numbers, current settings, and valid data range for each parameter. This report is generated from the information contained in the Unit Data (.uda) files.

To generate a Set Point report, click on ‘Set Point Report’ under the File menu (note this function is available only in MprComm version 3.3.8 or later). A file browser dialog will appear. Select the Unit Data (.uda) file which will serve as the source for the Set Point report, and click ‘Open’. A Preview window will appear displaying the contents of the Set Point report (see Figure #2A). To print a hardcopy of the report, click the ‘Print’ button located at the bottom of the Preview screen.

Exit - will exit the program.
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Screen Figure #2

[image: image4.png]X Set Point Report

MPR-9400 set points, firmware version 6.8.6

dow
200

Parameter
P2

Default
00

Data Range
Min=00, Max=09

205

[Equiode

Norrmal

Norrnal, EQU

205

[EquDays

0

Min=0, Max=25%

205h

[EquStarthr

0.00

205

[EquStop.

58.00

2054

[Equvboost

2.00

206

Da

00

207

[Seconds

27

208

DOW

Mon

Min=Sun, Max=5at

209

Ld1HrOn

0

1Min=0, Max=23

209

Ll MinOn

00

Min=00, Max=59

209

L1 Mode:

Disabled

Disabled, Enabled

210

Lol HrOff

0

Min=0, Max=23

210

L1 MinOff

00

211

ILd2HrOn

0

21

Ld2MinCn

(i1





Screen Figure #2A

Figure #3 shows the Toolbar buttons used to access the various screens when connected to an MPR-9400 controller;

Map - This selection will display a previously-installed site map. 

Status - This selection will access the Status window after the down loading process is finished. After the down loading process is finished,

The Status window will be the first window on the PC’s screen. See figure #9

Factory - This selection will access the Factory level. See figure #13

Install - This selection will access the Install level. See figure #12

Control - This selection will access the Controls level. See figure #11

Memory - This selection will access the 2 day Memory level. See figure #10
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Screen Figure #3

Figure #5 shows the “Security” screen. This screen will appear the first time you attempt to access the “Controls”, “Install”, or “Factory” screens

In order to change settings in the Controls, Install or Factory level you must first unlock the levels. When you unlock a level, the next screen will ask you to enter the correct combination number. Enter the number and click the unlock selection. After this is completed, you can now change settings in the level chosen.
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Screen Figure #5
Figure #7 - shows the “Tools” pull down menu;

Auto Answer - This command will place the software in Auto-Answer mode. Note that you must have a modem installed and properly configured in order for this option to function properly. The software will listen for incoming modem calls, and display an alarm screen if it receives an alarm callout from an MPR unit.

Connect – This will connect to an MPR unit, using the default communication method selected in the “Options” screen. Note that this is equivalent to clicking the “Connect” toolbar button.

Options – This brings up the “Options” dialog box (see figures #8A and #8B).

NEW for MPR-9400 PV version 5.02.00 and above: Ethernet (Local- and Wide-Area) communication capability has been added. See the addendum at the end of this documentation for details about configuring the Ethernet network parameters for the MPR-9400 unit.

Figure #8A - shows the ‘General’ tab of the Options screen (accessed from the ‘Tools’ dropdown menu). Use this tab to select the connection method that will be used when you click on the toolbar ‘Connect’ button. In the “Demo Firmware Version” dropdown box, you may select the version of firmware that will be emulated when the “Demo” communication method is selected.

Also on the General tab of the Options screen is the option to automatically refresh the Status window. When this option is enabled and the Status window is open, the Status window will be refreshed every 15, 30, 45, or 60 seconds (depending on the refresh interval chosen). In effect, this is equivalent to manually clicking the “Refresh” button on the Status screen continuously at the specified interval.
Figure #8B - shows the ‘Communication’ tab of the Options screen (accessed from the ‘Tools’ dropdown menu). In the ‘Network’ box, you may type in an IP address and Port number to use when initiating network connections manually (via the ‘Connect’ button on the main toolbar). In the ‘Modem’ box, you may select the modem that you would like to use when making modem connections to the MPR-9400. If your modem does not appear in the drop-down box, make sure its driver is installed correctly in the Windows Control Panel. In the ‘Direct Cable’ box, select which COM port you would like to use to establish direct-cable connections to the MPR-9400. The ‘Enable Email Alarms’ checkbox will enable emailed alarm reports when the software receives an alarm report via modem. Note that the ‘Auto Answer’ function must be enabled in order to receive alarm reports via modem. See the section below entitled ‘Using the MprComm software to generate email alarm reports’ for more information regarding the alarm email function.
Figure #8C - shows the ‘Polling’ tab of the Options screen (accessed from the ‘Tools’ dropdown menu). If Automatic Polling is enabled, the MprComm software will attempt to automatically contact each map Site at the specified interval and download its log data. See the “Using Automatic Polling” section of this manual for more details.
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Screen Figure #7
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Screen Figure #8A
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Screen Figure #8B
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Screen Figure #8C
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Screen Figure #9

Figure #10 - shows the “Memory” Window;
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Screen Figure #10

Figure #11 - shows the “Controls” Window;
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Screen Figure #11

Figure #12 - shows the “Install” Window;
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Screen Figure #12

Figure #13 - shows the “Factory” Window;
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Screen Figure #13
Figure #14 - shows the “Log” Window;
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Screen Figure #14

Figure #15 - shows the “Graph” Window;
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Screen Figure #15
GLOBAL PARAMETER UPLOAD SECTION

OVERVIEW

The MprComm software has the ability to record individual settings from one MPR controller and upload those settings to other MPR controllers via the Global Parameter Upload function. This function is similar to the Upload Unit Data function, with the following key differences:

· Whereas the Unit Data Upload function duplicates all settable parameters (with the exception of serial number and date/time) from one MPR unit to another, the Global Parameter Upload function allows the user to selectively specify which parameters are to be uploaded to the target MPR unit(s)

· The Global Parameter Upload function works in conjunction with Sites which are defined on the map screen, enabling the user to specify many Sites which are to receive the parameter updates. The updates are then uploaded to all selected sites in a single session.

The Global Parameter Upload screen

CAPTURING A LIST OF PARAMETERS

To capture a list of parameters to be used with the Global Parameter Upload function, first establish a connection to an MPR controller using any supported communication method (direct serial, modem, or ethernet). When you select “Global Parameter Upload” (located under the File menu in the MprComm software), the above screen appears. Note that the first time you select this option, the parameters list will likely be empty, since no parameters have yet been added to the list.

Parameters are captured into the parameters list using the “Capture Parameters” button. Click this button to enter the parameter capture mode. While the parameter capture mode is active, any parameter whose value is subsequently changed (on the Factory, Install, or Controls screens) will be added to the list of parameters in the Global Parameter upload screen.

When you have finished adding parameters to the list, click the “End Capture” button to exit the parameter capture mode. If you are unable to locate the Global Parameter Upload screen in order to click the End Capture button, note that it may be located behind another window which was subsequently opened. To find the open Global Parameter Upload window, either select it by name under the under the Window menu, or move or close other screens which may have appeared on top of the Global Parameter Upload screen.

If you would like to remove an item or items from the parameters list, simply select the item and click the “Remove Parameter” button. Likewise if you would like to remove all items from the list, click the “Clear List” button.

SAVING AND LOADING PARAMETER LISTS

Once a list of parameters has been captured using the above procedure, you may save the list to a file for later retrieval or to transfer it to another computer. Click the “Save List” button to save the currently-displayed list of parameters. A Windows file selection dialog will appear; navigate to the directory where you would like to store the file, and type an appropriate file name to save the file. Click the “Save” button to save the file. Note that the MprComm software will automatically append a “.gpu” extension to the file.

Saved parameter lists may be later retrieved by clicking the “Load List” button on the Global Parameter Upload screen. When the Load List button is clicked, a standard Windows file selection dialog will appear. Navigate to the folder containing the saved file, and select the file by clicking it in the displayed file list. Click the “Open” button to load the file. Note that when you load an existing parameter list file, and parameters currently displayed in the parameters list will be replaced by the parameters contained in the loaded file.

UPLOADING PARAMETERS TO OTHER MPR CONTROLLERS

The parameters that are currently displayed in the parameters list may be uploaded to any or all of the Sites that have previously been defined on any maps you have installed. For details regarding adding new maps and creating Sites, see the Maps section of this documentation.

To select the sites which are to receive the listed parameters, click the “Sites” tab near the top of the Global Parameter Upload screen. Place a check mark next to each site in the list which is to receive the uploaded parameters. Note that you must disconnect from the current MPR controller before initiating a Global Parameter Upload cycle – if you are currently connected to an MPR controller, click the “Hangup” button to disconnect.

Once you have selected all of the sites which are to receive the parameter settings, click the “Upload Parameters” button. Each selected site will be contacted in turn, and all of the parameter settings contained in the parameters list will be uploaded to the controller. After the MprComm software has contacted each selected site and has transmitted (or attempted to transmit) the parameter settings, a Results window will appear detailing which sites were successfully updated, and which sites, if any, were not successfully contacted.

WORKING WITH UNIT DATA (UDA) FILES

OVERVIEW

The MprComm software incorporates several functions pertaining to storing, displaying, and manipulating data which has been collected from MPR controller units. MPR unit data is saved in a Unit Data (UDA) file for later viewing or manipulation. Using UDA files, the user is able to:

· Transmit MPR unit data and parameters to another user via email

· Record the current state of an MPR controller for later viewing or printing

· Export MPR controller data to an ASCII text file format (TXT file) for use in other applications

· Upload the parameters from one MPR controller to another to ease setup of new installations and ensure uniformity of settings

SAVING A UNIT DATA FILE

To save a unit data file, a connection must be established to an MPR controller using any supported connection method (direct serial, modem, or ethernet). Once a successful connection has been made to an MPR controller, select the “Save Unit Data” option, located in the File menu of the MprComm application. A dialog box will appear asking the user to name the Unit Data file. Type an appropriate name into the File Name text box, and click the “Save” button. A “.uda” file extension will be automatically added to the end of the file name.

DISPLAYING A PREVIOUSLY-SAVED UDA FILE

Once a Unit Data file has been saved, it may be loaded at any later date for viewing or printing. To load a Unit Data file, first disconnect from the currently-connected MPR controller (if currently connected). Under the File menu, select “Display Unit Data”. A file dialog will appear prompting the user to select which UDA file to load. Select the appropriate file, and click the “Open” button. A display window will appear showing the various data parameters recorded in the UDA file. The parameters may be viewed on-screen, or printed by clicking the “Print” button.

UPLOADING A PREVIOUSLY-SAVED UDA FILE

Uploading a Unit Data file allows the user to quickly duplicate the settings and parameters from one MPR controller to another. Before using this function, please ensure that the firmware version of the MPR controller from which the data was saved matches the firmware version of the MPR controller that you are uploading the data to. If the firmware versions do not match, unpredictable behavior may result.

When you upload a UDA file to an MPR controller, all of that controller's settable parameters will be replaced by the parameters contained in the UDA file. Consequently, you will want to make doubly certain that this is what you intend to do; else it may take some time to reset the parameters back to their original values.

To upload a UDA file to a target MPR controller, first establish a connection to the target controller using any supported connection method (Direct serial, modem, or ethernet). Once a connection has been established, select “Upload Unit Data”, located under the File menu of the MprComm application. The process usually takes a minute or two, depending on the connection speed and latency.

EXPORTING A PREVIOUSLY-SAVED UNIT DATA FILE

To export a Unit Data file to an ASCII text (TXT) format, select “Export Unit Data File”, located under the File menu of the MprComm software. A file dialog will appear prompting the user to select a Unit Data file to export. Select and appropriate UDA file, and click the “Open” button. The exported file will appear in the same directory as the original UDA file, with the same name as the UDA file (with the exception that it will have a “.txt” file extension instead of “.uda”). The resulting TXT file may be imported into many external applications, such as a text editor or word processor.

USING AUTOMATIC POLLING
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The Automatic Polling function allows you to specify an interval at which the MprComm software will attempt to contact each map Site in turn and download the log data for each site. Note that the MPR controllers that you are polling must be equipped with the data logging option in order to use this function.

See the “Installing and Using Maps” section of this documentation for more information about creating Sites for use with the automatic polling function. After you have created all of the sites which you intend to poll, make sure that the “Enable Automatic Polling” option is enabled in the Site Properties screen for each site that you intend to poll.

Once Automatic Polling is enabled in the Site Properties window for each site which you intend to poll, open the Options screen (located under the Tools menu) and select the “Polling” tab. Place a checkmark next to “Enable Automatic Polling”, and select an interval at which the Sites will be contacted (daily, weekly, or monthly). After you have selected the interval, options will appear allowing you to specify on which Day-of-Month, Day-of-Week, and/or Time-of-Day to poll the Sites. Placing a checkmark next to “Automatically print log summary” instructs the MprComm software to generate a printed report of the log data for each Site as it is downloaded.

Upon the next occurrence of the specified polling interval, the Automatic Polling mode will be initiated. Each site will be contacted in turn, and its log data will be downloaded. Upon the successful download of all of the log data for a Site, the log data for that Site is automatically cleared to prevent duplicate ranged of data from being downloaded. After the MprComm software successfully downloads the log data, it will automatically place the data in a Log Data (.lda) file placed in the “Logs” directory in the MprComm installation directory. The log files will be named automatically according to the Site Number, Date and Time of download, and Site Name. The format of the automatically-generated filename is as follows:

Site#-YYMMDD.hhmmss(Site Name).lda

The .lda files generated by the Automatic Polling process may be displayed, printed, or graphed as normal using the appropriate functions located under the File menu of the MprComm software.

USING THE MPRCOMM SOFTWARE TO GENERATE EMAIL ALARM REPORTS

With MprComm software versions 1.1.4 and later, you may enable email alarm reports from the ‘Communication’ tab in the ‘Options’ screen (located under the ‘Tools’ dropdown menu). Note that this option is available only for modem-connected MPR-9400 units (network-connected MPR-9400 units also have the ability to generate emailed alarm reports; however, a separate SNMP management utility is utilized in conjunction with the SendMail utility in order to generate emails). If the ‘Enable Email Alarms’ option is activated, the MprComm software will send email alarm reports to designated email addresses when an alarm condition occurs. In order for this process to function correctly, the SendMail email client must be correctly configured. Upon installation of the MprComm software, a ‘SendMail’ folder will be created under the MprComm installation folder (the MprComm installation folder is usually ‘C:\MprComm’ if the program was installed to the default location). To configure the SendMail client, double-click the ‘mpr_SendMail.exe’ file in the SendMail folder to execute the SendMail program. The SendMail configuration screen (shown in figure #8d) should appear. In the ‘Email Host’ textbox, type in the name of the server that is used to send email from your network. The ‘Sender Name’ may be any name you choose (this appears in the ‘From’ field of the generated email). In the ‘Sender Email’ text box, type in the email address of the email account that will be used to send the outgoing alarm messages. The text contained in the ‘Subject’ text box will be used as the subject for the alarm email messages. To add a designated recipient, click on the ‘Add button’. You will need to supply the name and email address of the designated recipient. Click the ‘Alarm Messages’ button to view or edit the message content that will be generated when each designated alarm condition occurs. You may edit the messages if desired, or you may choose to accept the default messages for each alarm. When each of the above parameters have been correctly configured, you may close the SendMail program. The SendMail client is now configured and ready to send out email messages when the MprComm software receives an alarm report from a modem-connected MPR-9400 unit.
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Installing new maps in the MprComm software
[image: image20.png]
Screen Figure #4

Figure #4 shows the “Manage Maps” screen. Loading maps and creating site icons on the maps is an optional process, but it provides a convenient way for the user to interact with various MPR-9400 controllers in a multi-installation environment. If you choose to install a map or maps in the MprComm software, it is necessary to locate suitable map image(s) for the intended region(s). Many times, suitable maps may be found on the World Wide Web using various search engines such as Google Images. Map images should depict a region or regions where the MPR-9400 controllers are deployed in the field. In this way, the user may simply double-click on an icon on the map in order to establish a connection to the MPR-9400 controller at a particular location.

While practically any image may be used as a map in MprComm, a suitable map image should meet a few criteria for optimal viewability. If the map is intended to be viewed on a normal computer monitor with a 4x3 pixel aspect ratio, the map image should have an approximate aspect ratio (horizontal x vertical) of 4x3. For example, a 1024x768 will work well, since the approximate ratio between the horizontal and vertical pixel resolution is 4x3. Conversely, if the map is intended to be viewed on widescreen monitors, the map image should have approximately a 16x9 aspect ratio.

Once a suitable map image is located, it must be converted to Windows Bitmap format in order to be compatible with the MprComm software. Most Windows-based image-editing utilities (including Windows Paint, which is installed by default during a standard Windows installation) are capable of loading a graphics file of one format (jpg, for example) and saving it in Windows Bitmap format. Valid Windows Bitmap images will have a file extension of “bmp”. When saving the image in bmp format, a color depth of 24 bits should be used.

Once a suitable image file has been obtained and converted to Windows Bitmap format, start up the MprComm program and select "Manage Maps" under the File menu. Click the "Add New Map" button to add a new map. The new map is named "New Map" by default, but may be renamed by typing an appropriate name into the "Map Name" text box. To assign the bitmap file to the newly created map, click on the "..." button next to the File Path text box. This brings up a file selection dialog where you can select the map image (bitmap) file. Note that you may add multiple map images. If you have multiple map images added, select which map you would like to view using the Display Map button in the Manage Maps dialog box.

 

Once a new map has been added to the software, click the 'Map' button on the software's main toolbar to display the map. Once the map is displayed, you may add sites to the map by right-clicking the map image and selecting "Add New Site" from the popup menu. When the New Site icon appears on the map, right click it and select 'Properties' to edit the site. In the Properties dialog box, you may specify the Site Name, and the connection method to use to access the site. When you then double-click the site on the map, the software will attempt to connect to the site using the specified connection method.

To move a site icon to its proper location on the map image, right-click the site icon and select “Move” form the popup menu. A red circle appears around the icons to be moved. Left-click and drag the icon to move it to its new location.

You may add more map images to the MprComm software using the procedure described above. If you have multiple map images installed, you may select which map image you wish to view by clicking the “Manage Maps” option (under the File menu). Select the name of the map you wish to view, and click the “Display Map” button. If a map image is currently displayed, it will be replaced with the image of the map you selected (if a map image is not currently displayed, the newly-selected map image will be displayed the next time you click the “Map” button on the main toolbar.

Figure #4A: A sample MprComm screen with a map image displayed.

CONFIGURING A NEW MPR-9400 ETHERNET BOARD:
A knowledgeable network administrator should be present during this procedure!

For the purposes of this procedure, you will need to have a MPR-9400 unit connected to your LAN (Local Area Network) via a straight-through wired 10-base-T cable, or connected directly to your PC’s network card via a crossover-wired cable. In many cases, it is simplest to use a laptop computer and a crossover-wired cable to connect directly to the MPR-9400 ethernet board to be programmed. In this way, any firewalls that may be in place in the Local Area Network environment are bypassed during initial setup of the board.
1. Execute the supplied “Monitor.exe” program from your MPR-9400 software installation folder (Usually C:\MPR9400). You should see a screen similar to the following:
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2. The MPR-9400 network interface card(s) detected on the local area network are listed in green text in the list box which appears in the Monitor.exe program display. If no MPR-9400 units are detected on the local area network, check to verify that you are using the proper type of cable for your network connection, and make sure that you do not have a firewall in place which may be blocking local broadcast traffic. You may need to reconfigure your firewall to allow “broadcast packets” (packets sent to IP address 255.255.255.255); or if you are experiencing difficulty, you may wish to temporarily disable your network firewall.

3. Select a MPR-9400 by left-clicking on its IP Address in the list. Once a unit is selected, you may configure its communication parameters by clicking the “Config” button. The following dialog will appear:
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Type in the desired IP address, Gateway, and Subnet Mask to configure the MPR-9400 controller (you may need to contact your network administrator if you are unsure what to enter for these values). Leave the User ID set to “admin” and the password blank.

4. To prepare to connect to the MPR-9400 for the first time via the network interface, you will need to verify that the MPR-9400 software is properly configured for network access. Under the “Options” menu, select “Settings”. A settings dialog will appear. Select the “Network” tab to configure the MPR-9400 software network settings.
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In the “Remote IP” text box, type the IP address that you assigned to the MPR-9400 unit. As of this writing, the “Remote Port” should always be set to 4660. Click “OK” to save your changes. You will need to restart the MPR-9400 program for the changes to take effect.

OPTIONAL REMOTE COMMUNICATION HARDWARE

DIAL-UP MODEM/ISOLATION CARD 

P/N ACM-60001-00
FEATURES:

1. Compatible with MPR-9400 and MPR-9800

2. Communicates via analog telephone connection 

3. The ACM-60001-00 is equipped with an isolated power supply to accomplish the needed PCB power isolation, Viso & Giso.

4. The ACM-60001-00 is equipped with an RS232 chip coupled with an opto isolator to accomplish the communications isolation.

5. The ACM-60001-00 has the ability to be equipped with a 56K modem Modem with the isolated DB9 RS232 connection. OR without the Modem.

6. A program jumper selects the method of communication, either by RS232 OR Modem. 

7. Compatible with MPR-9400 and MPR-9800

2. GSM MODEM 

P/N MPR-GSM/F1 - Operates at  900/1800 Mhz.

P/N MPR-GSM/F2 - Operates at  850/1900 Mhz.

FEATURES:

1. Compatible with MPR-9400 and MPR-9800

2. Communicates via GSM protocols 

3. ETHERNET
P/N NE 9000-01

FEATURES:

1. Compatible with MPR-9400 and MPR-9800

2. Communicates via LAN OR WAN TCP/IP protocol

3. Allows the MPRs’ to send out SNMP alarm traps

4. Programmed at 10-Base-T

5. Isolated RS232 port

6. MPR’s automatically polls both RS232 port and Ethernet cards’ port
Troubleshooting
DST recommends that replacement cards are always available at the site.

Most operational failures will result in a low battery voltage condition (or load disconnect), and a few will result in high battery voltage.  A range of items can cause these system failures.  Some types of failure can cause either high or low voltages.  This manual is organized to discuss low voltage first, then high voltage, and finally other types of failures/problems.

Low battery or LVD

Many different conditions can cause a low battery voltage.  The system may have problems or the load may be using more energy than the system can generate at the sites location. These procedures should enable identification of the cause of problems and indicate the repairs needed.
Low voltage caused by controller problems

Circuit Breaker open or tripped

An open or tripped circuit breaker in the PV array charging circuit can cause a system low voltage condition. Always check that none of the circuit breakers are open or have tripped.

Sub-Arrays’ normally open MDRs are not energizing 
1. Check that the sub-array circuit breakers are engaged and operating properly.

2. Check that the controller is metering the correct battery voltage.

3. Check that the HVDs set points are correct.

4. Upon powering up, check that the PV current reading is a positive value. If not, contact DST.

5. Check HVD control wire connections, including the removable terminal blocks on the I/O card – P/N MPR-9402-04.

6. Confirm that the HVDs’ are instructed by the controller to be engaged or not by viewing WINDOW #4.

7. If Arrays are instructed to be energized, use a multimeter to check for voltage on the coil terminals of the MDRs. No system voltage value on the coil terminals of the MDRs indicates either a problem in the wiring to the MDRs or an internal failure of the control circuitry.

8. Replace card(s) and/or contact DST.

Sub-Arrays’ normally open MDRs are always energized

1. Confirm that the HVDs’ are instructed by the controller to be engaged or not by viewing WINDOW #4.

2. Check that the controller is metering the correct battery voltage.

3. Check that the HVDs set points are correct.

4. If Arrays are instructed to be de-energized, use a multimeter to check for voltage on the coil terminals of the MDRs. If the controller is instructing the MDR to be dis-engaged and there is system voltage across the MDR coil indicates a problem with the circuitry.
5. Replace card(s) and/or contact DST.

MPR not sensing correct battery voltage 

Proper operation of the MPR-9400 requires that the battery sense terminals be connected to the battery terminals to sense the exact battery voltage (without any effect of resistance in the power wiring). These leads should be fused to protect against a short circuit. 

1. An open connection, perhaps caused by an open fuse, will cause a lower than true battery voltage reading (2% to 5%). 

2. Reverse polarity connection of the battery sense leads will cause the MPR-9400 to sense 0 volts and the LCD meter will indicate 40.00 on a 48 volt nominal system (20.00 or 10.00 depending on the systems nominal voltage.  

3. Use a multimeter to check that the voltage on the sense terminals of the MPR-9400 is the same as the battery voltage measured at the battery main power terminals.

I/O board problems, P/N MPR-9402-04
Determining if the driver circuit is functioning properly. 
1. Reference the I/O PCB drawing on page 4. Testing of the relay drivers is accomplished by measuring the voltage across the 2 terminals for each relay driver located on the removable terminal blocks. The left 6 position terminal block which are labeled- HVD1, LOAD and AUX (AUX is HVD2) The third from the left terminal block which is labeled- CH7 (which is HVD3), CH8 (which is LVD2) and CH9 (which is the AC delay relay driver)] Reference the I/O PCB drawing to determine which FET relay driver needs to be tested. If the relay should be driven, there will be voltage across these terminals and if not there will be minimal voltage across these terminals. Check window #4 to determine if the relay channel should be driven. NOTE: DO NOT SHORT THESE TERMINALs, THE FET WILL BE DESTROYED IF SHORTED!
CPU problems P/N MPR-9401-01

Failure of the CPU card is not easily tested. Replace card or call DST
LCD problems
Changes in controller temperature may affect the contrast of the LCD display.  If the display is difficult to read or blank, hold down the LCD KeyPad to change contrast.
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ABSTRACT

An amp-hour counting battery charge control algorithm has been defined and tested using the Digital Solar Technologies MPR-9400 microprocessor based photovoltaic hybrid charge controller.  This work included extensive laboratory and field testing of the charge algorithm on vented lead-antimony and valve regulated lead-acid batteries.  The test results have shown that with proper setup amp-hour counting charge control is more effective than conventional voltage regulated sub-array shedding in returning the lead-acid battery to a high state of charge.  

INTRODUCTION 

Batteries in stand-alone and PV hybrid systems are commonly subject to abusive conditions that are generally due to, 1) under charging in low resource periods, 2) excessive charging in high resource periods, and 3) inappropriate or ineffective charge control for the battery technology.  The individual or combined effects of resource changes, poor charge control, and the daily load changes can be potentially damaging to the battery.  Previously available PV charge controllers or charge control strategies such as on/off PV array shedding will generally provide the battery with sufficient charging current to complete the bulk charge phase which will return the battery to 80 to 95% state of charge (SOC) [1,2].  After the bulk charge phase, the taper or absorption charge phase is very important in preventing stratification, hard sulfation, and premature capacity loss.  If a regulation voltage of 2.35 to 2.40 vpc is used for charging vented lead-antimony batteries, then a 10 to 24-hr regulated voltage finish charge period is usually required.  The available time for battery finish charging in PV systems is generally much less than 10-hrs.  The short time at regulation voltage results in an incomplete finish charge phase which consistently leaves the battery in an under charged condition.  If the regulation voltage for vented lead-antimony batteries is raised to 2.45 to 2.50 vpc and the reconnect voltage is raised to 2.28 to 2.30 vpc, then the finish charge time period can be significantly reduced.  With the higher regulation voltage, the battery may then be subject to excessive charge in high resource periods or low load periods.  The primary effect of the higher regulation voltage without amp-hour counting charge control on vented batteries is the dramatically increased watering requirements and increased erosion of active plate material.  For VRLA batteries the regulation voltage should be set to the manufacturers recommended value for a cycling application.  VRLA battery cycling regulation voltage is usually 2.35 or 2.40 vpc.  A reconnect voltage of 2.28 to 2.30 vpc is also very important to complete the finish charge period.  Very little can be done to accelerate the finish charge period for VRLA batteries because their charge acceptance is limited by the oxygen recombination cycle [3].  Higher regulation voltages will only accelerate dry-out.  That is why it is so very important to use constant voltage charging for the finish charge phase or simulate it with a well designed PV array shedding strategy.  

Based on energy calculations from the “RAPS Design Manual”, published by the University of Cape Town South Africa and the author’s own calculations, battery energy costs for PV hybrid systems are estimated to be about $0.35 to $1.00/kWh over the life of the system [4,5].  As indicated above, any degradation in battery cycle-life can result in a significant system cost increase.  The potential cost benefit to stand-alone and PV hybrid systems is substantial if batteries meet their rated cycle-life.  

Amp-hour (Ah) counting charge control for PV hybrid battery charging systems is new to this application, but in the Battery Technical Manual from Battery Council International the cycle-life test procedure for deep cycle marine/RV batteries does use Ah counting as a means to ensure the battery is at a high SOC [6].  In this test procedure the maximum and minimum values for percent overcharge per cycle for vented and VRLA batteries are specified.  This along with regulation voltage insures complete battery recharge.  

Maximizing battery cycle-life requires using the manufacturers recommended regulation voltages, appropriate system design, effective charge control, and reaching the recommended overcharge in Ah when the battery receives a full recharge.  The excess Ah are a way to compensate for battery efficiency losses.  For most vented lead-antimony batteries the recommended Ah overcharge is between 120 and 130% of the discharged Ah.  VRLA batteries, which require more time at regulation voltage, are much more efficient and only require between 105 and 115% of the discharged Ah.  This paper will evaluate an Ah counting charge control algorithm for PV hybrid systems using a microprocessor based charge controller.

AH COUNTING CHARGE CONTROL

In a cooperative effort with Digital Solar Technologies a microprocessor based Ah counting charge control algorithm was defined and tested using the MPR-9400 PV hybrid charge controller.  The controller under test uses staged PV sub-array switching to achieve a taper charge for the battery finish charge period.  This charge control method can be a very effective charge strategy if properly setup.  It is typically used in medium to large PV hybrid systems.  

The new Ah counting charge control algorithm calculates battery Ah for each complete cycle.  A new cycle is started when the battery reaches the predetermined overcharge in Ah.  To implement the new Ah counting charge algorithm required four new input variables.  These variables are:

1)  BATAHINIT - Estimated battery capacity in Ah (Input by user),

2)  AHVRESET - Battery voltage when battery charging or high voltage disconnects (HVD’s) are reactivated (Input by user),

3)  %ADD - Deficit or excess battery Ah at initial battery regulation voltage (Input by user - +or-25%),

4)  %OVER - Maximum overcharge above the daily Ah DOD (Input by user - 0 to 99%).

The Ah counting charge control algorithm opens the high voltage disconnect relays (HVD 1 and 2) when the specified %OVER plus %ADD Ah are charged into the battery.  The %OVER and %ADD Ah begin counting when the first HVD is reached.  Before the specified overcharge is reached, HVD 1 and 2 will operate as indicated by the preset disconnect and reconnect voltages.  The %OVER value is defined in equation 1.

((Ah chr - Ah dischr) / Ah dischr) x 100

(1)

Ah calculations for battery SOC and %ADD are based on the battery BATAHINIT capacity input by the user.  The displayed battery capacity in Ah and battery %SOC are reset to the BATAHINIT and 100% values respectively when the required overcharge is reached, or at 6 PM after an equalization charge.  If a load is turned on after charging is terminated, then the PV array will be reconnected when the battery reaches the preset AHVRESET voltage. 

SETUP AND INITIALIZATION

The MPR-9400 initialization for Ah counting charge control requires the user to identify the additional variables from the previous section.  The HVD 1 and 2 regulation voltage is generally available from the battery manufacturer and the reconnect voltage is usually set based on the sub-array shedding sequence and system design.  The %OVER, and BATAHINIT values are available from the battery manufacturer.  The %ADD parameter is very system dependent and can only be accurately identified by:

1) equalizing or boost charging the batteries, 

2) resetting BATAHINIT

3) running a standard cycle to regulation voltage,

4) recording the battery Ah when regulation voltage is reached, and

5) calculating %ADD by equation 2.

((BATAHINIT - Bat Ah at Vr) / BATAHINIT) x 100
(2)

In most cases the %ADD variable will be less than plus or minus 7%.  Test results have shown that as vented lead-antimony batteries age they will require adjusting the %ADD parameter from a positive number to less than –7%.  This is because of the increased gassing current resulting from antimony poisoning [7].  VRLA batteries typically will not experience significant changes in the %ADD value over their life because they generally have a stable end of charge current with very low gassing current.

PV SYSTEM SIMULATOR TEST RESULTS

The measured percent overcharge from three different stand-alone PV system simulations and a PV hybrid simulation has been obtained using an automated PV hybrid system tester from Team Specialty Products in Albuquerque.  This test-bed is capable of simulating two PV arrays or one PV array and one engine generator with two loads.  All system parameters are fully programmable and automated.  

Stand-Alone PV System Simulation

The stand-alone PV system test was conducted to evaluate Ah counting charge control using an array Ah to load Ah (C:L) ratio of 1.5, 1.75, and 2.0.  The simulation was configured to duplicate a typical stand-alone PV system using two 7-amp PV sub-arrays for battery charging.  The battery used in the system simulation was a GNB 12-5000X 400 Ah VRLA battery.  This battery is very similar to the GNB Absolyte IIP which is commonly used in larger stand-alone and PV hybrid systems.  A 1.5-amp continuous load and an adjustable nighttime load was used to establish the three different C:L ratios.  The new Ah counting charge control parameters for the MPR-9400 were input based on battery manufacturers specifications and the %ADD calculation from the above initialization cycle.  See Table 1 for a complete list of system parameters. 

In Fig. 1 are the test results, which show that the Ah counting charge control algorithm limits battery overcharge to within the 105 to 110% specified by GNB.  The voltage regulated charge period is also maintained between 1.9 and 2.3-hrs.  Using the same regulation voltages and system configuration without Ah counting charge control resulted in a battery overcharge range between 114 and 128%.  The voltage regulated charge period also varied between 3.9 and 5.0-hrs depending on the C:L ratio.  Without Ah counting charge control the only way to reduce overcharge is to lower regulation voltage or provide a two stage voltage regulated charge control.  The lower regulation voltage and two-stage charge control will decrease overcharge, but it will also increase the time required to charge the battery.  Voltage regulated charge control alone makes it very difficult to obtain optimum recharge due to weather and system design. 
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Table 1.  PV system simulator and charge controller setup parameters.
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PV Hybrid Simulation

The PV hybrid simulation was designed with one 7-amp PV array and an engine generator set to charge the battery at 20-amps once the 12.1 volt engine start voltage was reached.  The Charge Controller was programmed to terminate all charging when the required 107% overcharge was reached.  The system C:L ratio with one PV array was 0.62 and the %ADD input variable was still +1.9.  This system design resulted in the battery discharging to 12.1 volts during the fourth cycle.  The engine generator then returned the battery to full charge after the fourth cycle.

In Fig. 2 are the battery Ah and voltage plotted over a ten cycle period.  The measured overcharge values after the engine generator battery recharge were 110 and 111%.  The results indicate good reproducibility and they are close to the desired value of 107%.  This test is also useful in identifying the effects of different PV array C:L ratios and engine generator control strategies.  In this case the generator ran for a total of 3.5-hrs in bulk charge mode and 7.2-hrs in finish or taper charge mode for a total run time of 10.7-hrs returning 152 Ah back into the battery.  The end of charge current, which can be used to terminate charging, was measured at 3.9-amps.
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FIELD TEST RESULTS

In addition to the laboratory testing, the Ah counting charge control algorithm was used on two stand-alone PV systems with a 700 Ah Trojan L-16 vented lead-antimony battery and a 400 Ah GNB 12-5000X VRLA AGM battery.  These system tests represent each lead-acid battery technology and demonstrated that the Ah counting charge control algorithm will function well with each battery type even though they are significantly different in their recharge characteristics.  The most significant difference between the two battery types is the battery Ah at initial regulation voltage.  This charging difference is compensated for by the %ADD parameter in the MPR-9400. 

Ah Charge Control Using Trojan L-16 Batteries 

The stand-alone PV system using Trojan L-16 batteries is configured with three PV sub-arrays charging at a peak current of 16, 12, and 4-amps.  The two higher current sub-arrays are switched with the MPR-9400 charge controller and the 4-amp array is permanently connected to the battery bank.  The load is variable and is operational day or night.  Daily loads average 70 Ah/day but can range between 10 and 200 Ah/day.  The voltage setpoints on the MPR-9400 are set for staged sub-array switching at:

HVD-1 = 2.45 vpc Vr and 2.29 vpc Vrr, 

HVD-2 = 2.43 vpc Vr, and 2.27 vpc Vrr.

The Ah counting program parameters are set to:

BATAHINIT = 300 Ah

AHVRESET = 2.06 vpc

%ADD = -11.7

%OVER = 30

%OVER (0.30x70) + %ADD = -14.1 Ah

In Fig. 3 are the Ah overcharged and the respective percentage overcharge for a 15-day period.  The results indicate that the Ah overcharged are between 15 and 59 Ah with an average of 31 Ah.  The percent overcharge range is between 128 and 196% with an average of 153%.  These values are much larger and have a much wider range than would normally be seen in laboratory testing on new batteries.  These batteries are 5-yrs old, and as a result of normal aging processes, have experienced an increase in their gassing currents.  The higher gassing current requires more time for the battery to get to regulation voltage.  This results in a necessary but greater than normal overcharge.  Without Ah counting charge control, the Ah overcharged would be greater resulting in increased water loss and maintenance.
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Ah Charge Control Using GNB 12-5000X Batteries

A second stand-alone PV system using GNB 12-5000X VRLA AGM batteries is configured with two PV sub-arrays charging at a peak current of 7-amps each.  The two sub-arrays are switched with the MPR-9400 charge controller in a staged manner to simulate a taper finish charge.  The load is continuous and averaged 1.1-amps for a total of 26 Ah/day.  The voltage setpoints on the MPR-9400 were set for staged sub-array switching at:

HVD-1 = 2.36 vpc Vr and 2.30 vpc Vrr, 

HVD-2 = 2.35 vpc Vr, and 2.29 vpc Vrr.

The Ah counting program parameters are set to:

BATAHINIT = 250 Ah

AHVRESET = 2.04 vpc

%ADD = +3.5

%OVER = 10

%OVER (0.10x26) + %ADD = 11.3 Ah

In Fig. 4 are the Ah overcharged and the respective percentage overcharge for an 11-day period.  The results indicate that the Ah overcharged are between 2.4 and 4.6 Ah with an average of 3.6 Ah.  The percent overcharge range is between 109 and 118% with an average of 114%.  These values are higher than the test results from the indoor system simulator and indicate that a slightly lower %ADD value may be used.  The data also shows that in an actual PV system Ah counting charge control will be slightly less stable due solar and weather variations.

SUMMARY

Test results using the MPR-9400 Ah counting charge algorithm have shown that in typical stand-alone and hybrid PV systems Ah counting can improve battery charging over conventional voltage regulated sub-array switching by recharging the battery as quickly as possible without excessive overcharge during high resource or low load periods.  Appropriate overcharge is necessary to compensate for battery efficiency losses, prevent electrolyte stratification, prevent hard sulfation, and minimize premature capacity loss.  Excessive overcharge will accelerate dry-out in VRLA batteries and increase maintenance requirements for flooded/vented batteries.  Therefor, maintaining appropriate overcharge levels can improve battery cycle-life, lower maintenance costs, and reduce PV system life-cycle costs.  

REFERENCES

[1]  Woodworth, J.R., Harrington, S.R., Dunlop, J.D., et al, “Evaluation of the Batteries and Charge Controllers in Small Stand-alone Photovoltaic Systems”, First World Conference on Photovoltaic Energy Conversion, Hawaii, Dec. 1994.

[2] G.W. Vinal, Storage Batteries, John Wiley & Sons, 1951, ISBN 471908169, pp.240-271.

[3] M.L. Whitehead, “FAILURE MECHANISMS IN VRLA BATTERIES”, Proc. Of 8th Battery Conference and Exhibition, Solihull, UK, May 1994.

[4] University of Cape Town Energy for Development Research Centre, Remote Area Power Supply (RAPS) Design Manual, ISBN:0 7992 1435 3, Ph. (021) 650-3230, Sept. 1992.

[5] T.D. Hund, “Flooded Lead-Acid Battery Costs Vs. Valve Regulated Lead-Acid Battery Costs”, Internal Sandia Report, Aug.1997.

[6] Battery Council International, Battery Technical Manual 2nd Edition, 401 North Michigan Av. Chicago, Illinois 60611, (312) 644-6610.

[7] J.L. Dawson, M.I. Gillibrand, and J. Wilkinson, “THE CHEMICAL ROLE OF ANTIMONY IN THE LEAD-ACID BATTERY”, Power Sources 3, 1971, pp.1-11.




**IMPORTANT NOTICE**





Upon initial powering of the MPR-9400, set the local time using either the Keypad/LCD OR the “MPRCOMM” Program. If a time drift (inaccuracy) is noted after a period of usage, you can correct by setting the Time Correction Factor in the Control level Window #208 or in the Control Level screen of the MPRCOMM software. The Time Correction factor is the number of seconds added or subtracted from the MPR-9400 clock each night at midnight.
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Maximum PV amperage since last reset and the time it occurred








121 PV:  Max    MM/DD  hh:mm


Amps	462.38    12/28      13:02





Maximum systems input amperage since last reset and the time it occurred





120 In:   Max    MM/DD  hh:mm


Amps	1042.38  12/28      12:48





Maximum Load amperage since last reset and the time it occurred








119 LD:  Max   MM/DD   hh:mm


Amps	  912.08  12/10      18:09





Maximum systems output amperage since last reset and the time it occurred





118 Out: Max  MM/DD   hh:mm


Amps	  842.12  12/27      08:07





Minimum input amperage to the batteries since last reset and the time it occurred





117 Bat: Min  MM/DD   hh:mm


Amps	   0.00  12/29       16:55





Maximum input amperage to the batteries since last reset and the time it occurred





116 Bat: Max  MM/DD   hh:mm


Amps	  542.38  12/26      12:07





Minimum Battery’s voltage since last reset and the time it occurred





115 Bat: Min  MM/DD   hh:mm


Volts	  46.88  11/29       10:55





Maximum Battery’s voltage since last reset and the time it occurred





114 Bat: Max  MM/DD   hh:mm


 Volts	  54.88  12/22       13:44





Today’s minimum Controller’s temperature and the time it occurred





113  Unit °C:    Min      hh:mm


        Today        23         01:45





Today’s maximum Controller’s temperature and the time it occurred





112  Unit °C:    Max      hh:mm


        Today        29         11:45





Today’s minimum battery’s temperature and the time it occurred





111  Bat °C:    Min      hh:mm


        Today       24        01:41





Today’s maximum battery’s temperature and the time it occurred





110  Bat °C:    Max      hh:mm


        Today       31        11:12





Today’s maximum input amperage from the Wind and the time it occurred





109  Wind Amps: Max   hh:mm


        Today        23.33    08:16





Today’s maximum input amperage from the rectifiers and the time it occurred





108  Rect Amps: Max   hh:mm


        Today        529.93   04:36





Today’s maximum input amperage from the PV and the time it occurred





107  PV Amps: Max      hh:mm


        Today       322.23   11:12





Today’s maximum system’s input amperage from all sources and the time it occurred





106  In Amps: Max     hh:mm


        Today     828.84   09:45





Today’s maximum Load amperage and the time it occurred





LEVEL





105  LD Amps: Max     hh:mm


        Today      579.44   08:12





Today’s maximum system’s output amperage and the time it occurred





104  Out Amps: Max     hh:mm


        Today        651.23   08:12





Today’s batteries minimum input amperage and the time it occurred





103  Bat Amps: Min     hh:mm


        Today       56.14    12:34





Today’s batteries maximum input amperage and the time it occurred





102  Bat Amps: Max     hh:mm


        Today       546.12    04:24





Today’s minimum Battery voltage and the time it occurred





101  Bat Volts: Min     hh:mm


        Today       52.47     07:16





Today’s maximum Battery voltage and the time it occurred





100  Bat Volts: Max     hh:mm


        Today       54.27     04:24





Watts/m2= Magnitude of the solar radiation








18  SUN: Watts/m2


  *                  955








Volts=  Temperature compensated volts added or subtracted (neg value) from the HVD’s and Generator’s voltage set points





17b  Tcomp: Volts


  *                   2.15 








Disc= HVD#1’s temperature compensated disconnect voltage


Recon= HVD#1’s temperature compensated reconnect voltage





17  Comp HVD1:  Disc    Recon


  *                          54.35    51.15








DOW= Day Of The Week


YY/MM/DD= Year/Month/Day


hh:mm:ss= Hour:Minutes:Seconds





16  DOW  YY/MM/DD hh:mm:ss


  *   Wed     04/01/07    12:46:54 








Bat= Battery temperature


Unit= Controllers internal temperature





15 °C:Bat        Unit  


 *        27           30 














Rect= Total Amp Hours supplied by the RECT through the Rect shunt circuit only since a reset


Wind= Total Amp Hours supplied by the Wind through the Wind shunt circuit only since a reset





Note: Values reset at 24:00 





14 Ahrs In:      Rect          Wind


 *    Total      7215.70           0.00








Tot= Total Amp Hours supplied to the system from all sources since a reset


PV= Total Amp Hours supplied by the PV through the PV shunt circuit only since a reset





Note: Values reset at 24:00 





13 Ahrs In:      Tot               PV


 *   Total        20443.2     13227.5








Tot= Total Amp Hours supplied to systems Loads since a reset


LD= Total Amp Hours supplied to the Loads through the load shunt circuit only since a reset








12 Ahrs Out:  Tot            LD


 *    Total     15020.4       6537.29








In= Total Amp Hours supplied to the batteries from all charging sources since a reset


Out= Total Amp Hours sourced from the batteries since a reset








11  Bat AHrs:      In            Out


 *    Total        9896.34    9665.87








Rect= Today’s Amp Hours supplied by the RECT through the Rect shunt circuit only


Wind= Today’s Amp Hours supplied by the Wind through the Wind shunt circuit only


Note: Values reset at 24:00 





10  AHrs In:        Rect       Wind


 *    Today	   674.68       0.00








Tot= Today’s total Amp Hours supplied to the system from all sources


PV= Today’s Amp Hours supplied by the PV through the PV shunt circuit only


Note: Values reset at 24:00 





9  AHrs In:	  Tot             PV


 *  Today        987.33       312.65 








Tot= Today’s total Amp Hours supplied to the system’s Loads


LD= Today’s Amp Hours supplied to the Loads through the load shunt circuit only


Note: Values reset at 24:00 





8  AHrs Out:	  Tot              LD


 *   Today       622.44        622.44








In= Today’s Amp Hours absorbed by the Batteries


Out= Today’s Amp Hours supplied from the batteries


Note: Values reset at 24:00 





7 Bat AHrs:         In            Out


 *   Today  	 565.62      418.57








GenFault= Indicates if a fault signal from the GEN is detected, *= fault detected 


Fault2= Indicates if a run signal from the GEN is detected, *= GEN running





6 Gen:GenFault           Fault2


 *               -		       -








LastErr= Last type of GEN fault error. Low Curr= Low current fault. Gen Fault= fault signal from GEN received. 


HrsAlarm= GEN run time has reached the Maintanance Hours Alarm. See Window #216b





5b Gen: LastErr          HrsAlarm


 *              None                   -








GEN= Indicates the ON or OFF state of the GEN. ON= GEN ON, OFF= GEN OFF


ACD= Indicates the ON or OFF state of ACD. Conn= ON, Disc= OFF


GenHrs= Indicates total run time of the generator since last reset








5   GEN    ACD     GenHrs


 *    Off     Disc      268:00       








PV= Indicates the ON/OFF state of HVD1,2 and 3. If ON, the HVD# is visible, 1,2 &3


LD= Indicates the ON/OFF state of LVD1 & 2. If ON, the LVD# is visible, 1 & 2


HVA= Indicates the ON/OFF state of HVA. If ON, the * is visible


LVA= Indicates the ON/OFF state of LVA. If ON, the * is visible








4 :PV    LD      HVA      LVA 


 * 1--     12         -            *  





PV= PV amperage provided from PV arrays


Rect= Amperage provided from the Generator/Rectifier


Wind= Amperage provided from the Wind generator





3 Amps:PV      Rect        Wind


 *    215.05      200.74       0.00





In= Charge amperage provided from all charging sources


Out= Load amperage provided to the system


LD= Load shunts circuit amperage





2 Amps:In   	  Out          LD


 *  123.79         36.40      28.40      





TimeRem= Approx. remaining Load ON time


AHrs= Battery’s Amp Hour capacity





301 HVD1: Mode  Disc Recon                 


	     Auto    56.60    55.20 





CHECK SYSTEM





1 Bat:      TimeRem         AHrs


 *              10:05:00        4212.5





Amps= Battery’s Net amperage


Volts= Battery’s DC voltage


%SOC= Battery’s State Of Charge





  Bat:Amps    Volts     %SOC


  *     53.5	54.40   100.0

















SET





Enter NEW Lock Num


                00 00 00 





CLEAR





!	      UNLOCKED	   !


 PRESS CLEAR TO CONTINUE 





FIELD











300  Enter  Lock Num 


	        20 30 40





FIELD





300  Enter  Lock Num 


	        20 30 00























302 HVD2:Mode  Disc   Recon


	Auto     56.60  55.20 





300  Enter  Lock Num 


	        20 00 00





302 HVD2:Mode  Disc   Recon


	 Auto   56.30   55.20 





SET





CLEAR














5b Gen: LastErr             HrsAlarm


                None                      -





  Bat:Amps    Volts     %SOC


  *     53.5	54.40   100.0











5   GEN    ACD     GenHrs


      On      Disc      268:00       












































LEVEL





LEVEL














Fig. 1.  VRLA battery % overcharge with and without Ah counting charge control.





Fig. 2.  PV hybrid simulation using Ah counting charge control.





Fig. 3.  Stand-alone PV system using Ah counting charge control and vented Trojan L-16 battery.





Fig. 4.  Stand-alone PV system using Ah counting charge control and GNB 12-5000X VRLA AGM battery.
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Bat:Amps      Volts          %SOC


*     53.5	 54.40    100.0
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217 ACD:StartMin  EndMin 


                      1             1 











216c GenFault Delay: Sec 


                                       5 





216b Gen:MaintHrsAlarm 


                        240 





216 Gen: HrMax   


                   12            





215 Gen: Aoff        Vthr 


                  20         51.00 





214 Gen:WaitDays RunMins 


                        14            10





213 Gen:Mode  Von      Voff	              


        Gen-Off     24.80     25.90





204b Reset Gen Error


           (Press Set)





204 Reset Gen Hours


           (Press Set)





203 Reset Min/Max Data


           (Press Set)





Resets on-going Amp Hour logging displayed in Level 0’s Windows





202 Reset AmpHour Totals


          (Press Set)





Immediately backs up today’s logging data if set. Useful if controller has to be powered down





201 Backup Today’s Data


          (Press Set)





Enter Levels Lock Number if different than 00 00 00.





200  Enter  Lock Num 


	        00 00 00





Minimum Controller’s temperature since last reset and the time it occurred





127 Unit:Min    MM/DD  hh:mm


°C	16          12/20      01:18





Maximum Controller’s temperature since last reset and the time it occurred





126 Unit:Max    MM/DD  hh:mm


°C	 32          12/10     14:02





Minimum battery’s temperature since last reset and the time it occurred





125 Bat: Min    MM/DD  hh:mm


°C	     6        12/20     02:14





Maximum battery’s temperature since last reset and the time it occurred





124 Bat: Max    MM/DD  hh:mm


°C	     34       12/10     13:38





Maximum Wind amperage since last reset and the time it occurred








122 Wind:Max  MM/DD  hh:mm


Amps	 75.72    12/18     14:15





Maximum Rectifier amperage since last reset and the time it occurred








122 Rect:Max  MM/DD  hh:mm


Amps	775.72    12/18     10:44





Resets all Min/Max logging displayed in Level 100’s Windows





204 Reset Gen Hours


           (Press Set)





Resets logged generator hours





204b Reset Gen Error


           (Press Set)





Resets generator’s fault errors to permit the generator to operate





205 Charge Type


          Normal





Set to either “Normal” (standard finish charge) OR to “Equalize” mode





205b AutoEQU: Days   TimeOn


                             15        23:00





Days= # of days between automatic equalization cycles


TimeOn= Time of day this automatic cycle is initiated





205c EQU MaxTime: Hrs                             		            12





Hrs= Maximum allowable equalization time. During an equalize cycle and the generator is the energy source, this setting will limit the Generator’s run time





205d EQU: Vboost  StopV                             	         2.00       59.00





Vboost= The voltage added to the HVD’s set points during an equalize cycle and the PV arrays are the energy source


StopV= Both equalize cycles will terminate at this battery’s voltage





206 Date:  YY/MM/DD


                    04/01/07





Program the Year, Month and Day





207 Time:       hh:mm:ss


                        12:14:06





Program the Hour, Minutes and Seconds of local time








208 DayOfWeek        TimeCorr


              Wed                     0





DayOfWeek= Program the Day Of the Week


TimeCorr= Programs the observed daily clock drift 








209 LD1 Timer   Ton     hh:mm


    Disabled	                06:00





Timer= Enable OR Disable Load #1’s daily time to turn on the Load 


Ton-hh/mm= Load #1’s time of day to turn on 








210 LD1            Toff   hh:mm


		            20:00





Toff-hh/mm= Load #1’s time of day to turn off





211 LD2 Timer   Ton     hh:mm


   Disabled	                06:00





Timer= Enable OR disable Load #2’s daily time to turn on the Load 


Ton-hh/mm= Load #2’s time of day to turn on 








212 LD2            Toff   hh:mm


		            20:00





Toff-hh/mm= Load #2’s time of day to turn off





213 Gen:Mode  Von      Voff	              


        Gen-Off     24.80     25.90





Mode= Gen ON,OFF,Timed and Current Modes


Von= Generators low voltage turn on set point


Voff= Generators high voltage turn off set point- Critical setting!








214 Gen:WaitDays RunMins 


                        14            10





WaitDays= Days between generator maintenance run cycles


RunMins= Maintenance run minutes- Critical setting!





215 Gen: Aoff        Vthr 


                  20         51.00 





Aoff= Rectifier’s input current amperage at which generator is stopped


Vthr= Battery’s voltage at which the current control algorithm takes effect


Critical setting!








216 Gen: HrMax   


                   12            





HrMax= Maximum allowable generator’s run hours 


Critical setting!








216b Gen:MaintHrsAlarm 


                        240 





MaintHrAlarm= Maximum hours that the generator may run before a generator maintenance is required





216c GenFault Delay: Sec 


                                       5 





Sec= Number of seconds to wait before reporting a generator fault condition





217 ACD:StartMin  EndMin 


                      1             1 





StartMin= Minutes of delay to enable ACD’s relay driver after starting the generator


EndMin= Minutes of delay to disable ACD;s relay driver before stopping the generator   


Critical setting!








300  Enter  Lock Num 


	        00 00 00








Enter Levels Lock Number if different than 00 00 00.





301 HVD1:Mode  Disc   Recon


                 AUTO  56.5      55.4





Mode= Auto, ON or OFF  


Disc= HVD’s Voltage Disconnect setting


Recon= HVD’s Voltage reconnect setting   








302 HVD2:Mode  Disc   Recon


                 AUTO  56.2     55.1





Mode= Auto, ON or OFF


Disc= HVD’s Voltage Disconnect setting


Recon= HVD’s Voltage reconnect setting   








303 HVD3:Mode  Disc   Recon


                 AUTO   55.9     54.9





Mode= Auto, ON or OFF 


Disc= HVD’s Voltage Disconnect setting


Recon= HVD’s Voltage reconnect setting   








304  LVD Delay:          Seconds


		                2








Seconds= LVD1’s and LVD2’s number of delay seconds before reacting 





305 LVD1:Mode  Disc   Recon


            AUTO      45.40   49.00





Mode= Auto, ON or OFF


Disc= LVD’s Voltage Disconnect setting


Recon= LVD’s Voltage reconnect setting   








306 LVD2:Mode  Disc   Recon


            AUTO      45.90   49.50





Mode= Auto, ON or OFF


Disc= LVD’s Voltage Disconnect setting


Recon= LVD’s Voltage reconnect setting   








307  Alarms Delay:Seconds


		                2





Seconds= Alarm’s number of delay seconds before reacting 





307b  HVA:    Von         Voff


	         60.80       56.60





Von= HVA’s ON voltage setting


Voff= HVA’s OFF voltage setting








307c  LVA:	Von	Voff


	           47.00	51.00





Von= LVA’s ON voltage setting


Voff= LVA’s OFF voltage setting








309 Tcomp: (mV/cell/°C)


                                 -5.5





mV/cell/°C= Temperature compensation coefficient. Set to battery manufacturer’s recommendation








310  Tcomp Range °C: Max				      50





Max= Limits the temperature compensation effect above this setting





310  Tcomp Range °C: Min				      0





Min= Limits the temperature compensation effect below this setting








313 BAT: Installed AH


 		      5000





Installed AH= Setting of the fully charged battery’s Amp Hour capacity when initially installed 








314 BAT: %Effic


	        90





%Effic= Setting of the battery’s overall charging efficiency 








Amps= PV amperage input threshold that will disconnect arrays. This prevents energy backflow during the night








315 Dark Protect: Amps


                                  1





316 Dark Protect: Mins


   			10





Mins= Array connection cycle in minutes, during no solar input





316 Charge Mode


           Voltage





Mode= Voltage OR EBBM. Set at Voltage Not EBBM





318 Logging: Minutes


 	              15





Minutes= 1,5,15,30 OR 60 Logging sample intervals. 





319  2nd Comm Interface


 	              Modem





Comm Interface= None, Modem, Ethernet (Network) OR Modem Type2.





400  Digital Solar Tech


        MPR-9400  FW 6.08.06





Displays model type and Firmware version





401  Serial Num


	07 02 02





Displays unit’s Serial number. Year, Week number of the year and unit number produced during this week 





402  Vnom


	 48





Vnom= 12,24,36,48,60,72,84,96,108,120. Setting system’s nominal voltage 





403  Bat: Cal     Zero	


	    238        4	





Cal= Battery’s voltage metering calibration- Gain Factor  


Zero= Battery’s voltage metering calibration- Offset factor





404 Load:  Cal   Zero   Shunt


	       79     128      100





Cal= Load’s amperage metering calibration- Gain Factor  


Zero= Load’s amperage metering calibration -Offset factor


Shunt= Load Shunt’s amperage rating @ 50mV 





405 PV:     Cal   Zero   Shunt


	       79     128      400





Cal= PV’s amperage metering calibration- Gain Factor  


Zero= PV’s amperage metering calibration- Offset factor


Shunt= PV Shunt’s amperage rating @ 50mV 





406 Rect :   Cal   Zero   Shunt


	       79     128      200





Cal= Rect’s amperage metering calibration- Gain Factor  


Zero= Rect’s amperage metering calibration -Offset factor


Shunt= Rect Shunt’s amperage rating @ 50mV 





407 Wind:   Cal   Zero   Shunt


	       79     128      200





Cal= Wind’s amperage metering calibration- Gain Factor  


Zero= Wind’s amperage metering calibration -Offset factor


Shunt= Wind Shunt’s amperage rating @ 50mV 





408 Bat Temp:  Cal	


	  	    3





Cal= Battery’s temperature metering calibration- Gain factor  





409 Unit Temp:  Cal	


	 	    -3





Cal= Controller’s internal temperature metering calibration- Gain factor  





409 Sun:           Cal	


	  	  160	





Cal= Solar Insolation metering calibration -Gain factor  





6 Gen:GenFault           Fault2


                  -		       -
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LCD





Bat:Amps       Volts          %SOC


*       53.5	  54.40     100.0
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